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INTRODUCTION 

About This Document 
This document covers Smar WebHMI™ product, including:  

• WebHMI installation 

• Accessing and viewing WebHMI samples 

• Web Publishing Wizard for publishing GraphWorX, AlarmWorX, and TrendWorX display files as 
Web pages 

• AlarmWorX Web Access support for reports and operator comments. 

• Setting up the WebHMI server 

• WebHMI client configuration using the GenBroker™ Configurator  

• GenBroker communications 

• WebHMI licensing configuration 
• WebHMI security configuration 

• Change Host Utility 

• WebHMI versions support and the Update Versions Utility 
 

This document assumes you have prior knowledge of the following: 

• Smar ProcessViewcomponents. 

• HTML or Web page editing tools that can handle ActiveX controls. 
• TCP/IP setup or DCOM (Distributed Component Object Model). 

Note 
Remote node names in ProcessView are often referenced by  "\\<Node Name>." In this document, 
you will often see a remote OPC data source referenced by "\\<IP Address>." This convention is 
perfectly acceptable and simplifies the development of WebHMI Web pages. 

New Features in WebHMI 
WebHMI version 7.0 includes the following new features: 

• New VBScript and JScript scripting engine (see the GraphWorX Help documentation for more 
information). 

• WebHMI Security Login ActiveX. 

• AlarmWorX Web Access support for reports and operator comments. 

• TraceWorX diagnostics support 

• Integrated Web browser support for both Microsoft Internet Explorer and Netscape Navigator. 

Note 
WebHMI version 7.0 currently does not support Netscape Navigator 7.0. 
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Introduction to WebHMI 
Smar WebHMI is a Thin Client Web solution that enables standard Web browsers, such as 
Microsoft® Internet Explorer and Netscape® Navigator1, for use as real-time operator interfaces to 
manufacturing and factory floor applications. Based on ActiveX® technology, WebHMI provides you 
with a powerful and versatile approach to using the same standard HMI (Human Machine Interface) 
components included in ProcessView Enterprise Edition™.  

WebHMI delivers industry-standard, real-time OPC (OLE for Process Control) information. WebHMI 
likewise delivers fast, worldwide operator graphical visualization, trending and alarming 
information—both real-time and historical—and HTML-based reports.  

Since WebHMI Web components are packaged in standard Microsoft .cab files (or in the case of 
Netscape are referenced by .dpl files), your server and clients can be located anywhere. Similarly, 
you can store .cab or .dpl files anywhere on your network. Installed and resident on one or more 
WebHMI servers, these components (e.g., GraphWorX, TrendWorX, or AlarmWorX) are delivered 
automatically, quickly, and “in the background” to a browser on the client-side machine. Since 
WebHMI delivers the necessary components required for performing HMI and SCADA functions 
(e.g., building control, manufacturing, and process monitoring), it is not necessary to have any Smar 
products installed on the client machines. 

Ultimately, WebHMI turns a Web browser into an OPC client when the browser views Web pages 
located on any WebHMI server. As mentioned above, standard browsers such as Microsoft Internet 
Explorer and Netscape Navigator are used to view Web pages from the WebHMI server. Once a 
WebHMI site is up and running, you can instantly create multiple browser stations by having your 
clients launch the Web browser and visit the appropriate page.  

Interaction between clients and the WebHMI server is made possible by Smar GenBroker™, which 
uses TCP/IP communication over the Internet. The GenBroker Configurator allows you to customize 
your client/server architecture based on your network configuration. For information about WebHMI 
client configuration, please see Chapter 5. For information about configuring GenBroker for the 
server side, please see the GenBroker Help documentation. 

WebHMI Product Contents 
Once you have installed WebHMI on a Web server, the following components are available: 

• .cab or .dpl files containing all necessary Smar ActiveX components and foundation files. 

• Registered copies of all WebHMI ActiveX components, which aid in the development of your 
own pages. 

• Installation files for Microsoft Windows NT® and Windows® 2000. 

• Several sample HTML projects, which any client can browse “out of the box.” 

• A search-and-replace application, which can find and replace strings in HTML files, dynamic 
tags in GraphWorX display files, and pen names in TrendWorX property page configuration files. 

WebHMI Architecture 
The architecture of WebHMI can best be explained in an illustration. Figure 1.1 shows the WebHMI, 
Security, Licensing, and OPC servers on the same node. The WebHMI clients are used to view Web 
pages downloaded from the WebHMI server through a Web browser. GenBroker acts as a bridge 
that links WebHMI clients to the WebHMI server over the Internet using TCP/IP communications. 
For details about client/server architecture and GenBroker configuration, please see Chapter 5 or 
refer to the GenBroker Help documentation. 

                                                           
Special note to users with Netscape Navigator: Netscape Navigator does not support ActiveX technology. 
Smar has solved this problem by supplementing Netscape with a plug-in. Acting as a bridge, this plug-in allows 
for an ActiveX component to be put into the special Netscape module.  
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Figure 1.1. WebHMI Client/Server Architecture 

Of course, you are not limited to this setup. Since ProcessView is modular, various components can 
be spread out over PCs with multiple networks. If you wish, you can have a single node devoted 
only to storing and supplying all necessary data files to be transported over HTTP; or you can have 
a setup in which any other node can be responsible only for supplying security information and 
serving Smar licensing. You can have as many nodes as you wish supply OPC data.  

TraceWorX Support 
Using a technology that has been incorporated into all Smar products, TraceWorX provides online 
diagnostics and tuning of applications running in the ProcessView system. TraceWorX is designed 
expressly for systems integrators, OEMs and customers who want to have tools for doing their own 
troubleshooting and diagnostics. 

TraceWorX tracks the runtime activity for each ProcessView application and logs the runtime data to 
a log file based on user-configured trace levels. The log file provides a thorough, color-coded report 
detailing all activity for the application, including the time, the date, the severity level, and a 
description of the event or problem.  

TraceWorX also features several options for reporting issues to technical support. If you are 
experiencing problems with any applications, the log file deployment options, such as compressing 
and e-mailing log files, are ideal for tracking and archiving data and sending detailed reports to 
technical support. Developers can use these reports to identify the source of the problems. 

The TraceWorX32.htm file, which contains the TraceWorX Configuration Utility, is installed with 
ProcessView in the Program Files\SMAR\ ProcessView\Bin directory. Remote WebHMI clients can 
download this utility from the WebHMI Server by specifying the URL address of the 
TraceWorX32.htm file (e.g. http://www.myserver.com/WebHMI/TraceWorX32.htm). The TraceWorX 
Utility will track any problems on the remote client.  

Note 
The View button on the TraceWorX Configuration Utility is disabled in WebHMI. 

 
For more information about using TraceWorX, please see the TraceWorX Help.htm file in the 
Program Files\Smar\ ProcessView\Bin directory, or see the TraceWorX Help documentation on the 
ProcessView product CD.  
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2.1 

SETTING UP THE WEB SERVER 

Introduction 
In this chapter, the following topics will be covered: 

• Installing Internet Information Server in Windows NT 

• Installing Internet Information Server in Windows 2000 

• Installing a Personal Web Server in Windows NT 

• Installing ProcessView 

• Installing the ProcessView License Utility 

• Installing WebHMI 
 
Before installing WebHMI, you must first install a Web server, ProcessView, and a ProcessView 
software license. Any Microsoft Windows operating system that meets the ProcessView minimum 
system requirements and that has a Web server installed is capable of serving WebHMI pages. 
However, it is strongly recommended that you use Microsoft Internet Information Server (IIS) 
because IIS supports all features of WebHMI.  Other Web servers, such as Personal Web Server 
and Apache®, may not support all features of WebHMI.  

Note 
The ProcessView Web Publishing Wizard is supported only for IIS version 4.0 or above. 
SOAP/XML is supported only for IIS version 5.0 or above. 

Installing Web Servers for Windows NT and Windows 2000 
For WebHMI to work properly on a PC, you must install the following: 

• For Windows NT: Either Internet Information Server (IIS) or a Personal Web Server. 
• For Windows 2000 or Windows XP: Internet Information Server (IIS). 

Installing Internet Information Server for Windows NT 
If you run a Windows NT server, you must install an Internet Information Server (IIS) in your 
computer.  

 

1. To install IIS in Windows NT, click on Network Neighborhood on your computer's desktop. The 
Network dialog box will appear, as shown below in Figure 2.1. On the Network dialog box, click 
the Services tab and then click the Add button. 
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Figure 2.1. Network Dialog Box: Services Tab 

 

2. The Select Network Service dialog box will appear. Select the Network Service (in this case 
Microsoft Internet Information Server), and click the OK button. 

3. The Internet Information Server Installation dialog box will appear, as shown in Figure 2.2. 
This dialog box will inform you that additional files are needed for installation. In the Installed 
from field, type in the drive on which your computer runs CD-ROMs, plus ":\i386"; or click on the 
Browse button to locate the i386 folder on your CD-ROM drive. After locating the i386 folder, 
click on it to have it appear in the Installed from field. Insert the Windows NT CD-ROM and click 
on the OK button on the Internet Information Server Installation dialog box.   

 

Figure 2.2. Internet Information Server Installation Dialog Box 
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Note 

The Network Service required for this setup is Microsoft Internet Information Server 3.0, to be 
released at the time of the current document's publication. 

 
Note 

The Microsoft Internet Information Server Setup dialog box, with an Options window, will 
appear, as shown in Figure 2.3. In the Options window, be sure to click on at least the four X-
boxes (Internet Service Manager, World Wide Web Service, WWW Service Samples, and 
ODBC Drivers & Administration). Click the OK button. 

 
4. The Publishing Directories dialog box will appear. On the Publishing Directories dialog box, 

the default directory ("C:\InetPub\wwwroot") will appear in the World Wide Publishing 
Directory field.  To use this directory, click the OK button. 

 

 
Figure 2.3. Options Window of Microsoft Internet Information Server Dialog Box 

5. If the default directory does not exist in your computer, a dialog box will appear informing you of 
this fact, as shown in Figure 2.4. If you wish to create the default directory 
("C:\InetPub\wwwroot"), click Yes. 

 

Figure 2.4. Creating the C:\InetPub\wwwroot Directory 

6. After the "C:\InetPub\wwwroot" directory has been created, the Install Drivers dialog box will 
appear, as shown below. One or more ODBC drivers will appear in the Available ODBC 
Drivers pane of the Install Drivers dialog box. Select the driver(s) of your choice and click OK.  
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7. The Microsoft Internet Information Server dialog box will appear, informing you that the setup 
has been completed. On the Microsoft Internet Information Server dialog box, click the OK 
button.  

 

You have successfully installed Internet Information Services software on a PC with Windows NT.  

 

Installing Internet Information Server for Windows 2000 
If you have Windows 2000 with Internet Information Server (IIS), you must configure it in your 
computer.  

1. To configure IIS in Windows 2000, enter the Control Panel on your computer and click on 
Add/Remove Programs. The Add/Remove Programs dialog box will appear. Click on the 
Add/Remove Windows Components icon in the left-hand column of the dialog box.   

2. The Windows Components Wizard dialog box will appear, as shown in Figure 2.5. To add IIS, 
select Internet Information Services (IIS) and click on the check box. After you have clicked on 
the IIS check box, the Windows Components Wizard dialog box will change its appearance 
and begin configuring components. Shortly after the configuring begins, you could be notified 
that additional files are needed. 

 

Figure 2.5. Windows Components Wizard Dialog Box 

 
3. If additional files are necessary, the Files Needed dialog box will appear, as shown in Figure 

2.6. In the Copy files from field, type in the drive on which your computer runs CD-ROMs, plus 
":\i386"; or click the Browse button to locate the i386 folder on your CD-ROM drive. After 
locating the i386 folder, click on it to have it appear in the Copy files from field. Insert the 
Windows 2000 Professional CD-ROM and click on the OK button on the Files Needed dialog 
box.  
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Figure 2.6. Files Needed Dialog Box 
 

4. The Windows Components Wizard dialog box will reappear. The copying of files is tracked on 
the progress bar of the window. 

5. After all of the necessary components have been installed, the Finish dialog box will appear. To 
close the Windows Components Wizard dialog box, click the Finish button. 

 
You have successfully configured Internet Information Services software for Windows 2000.  

Installing a Personal Web Server for Windows NT 
If you run a Windows NT server, installing a Personal Web Server is an alternative to installing an 
Internet Information Server (IIS) in your computer.  

1. To install a Personal Web Server, go into the Tools directory on the Microsoft Windows NT® 4.0 
Options Pack CD-ROM and select Tools\pws. The Option Pack Setup window will appear, as 
shown in Figure 2.7. 

 

Figure 2.7. Microsoft Windows NT 4.0 Option Pack Setup 
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2. Click the Next button. The End-User License Agreement dialog box will appear. Read the 
conditions in the License Agreement. If you accept the conditions, click the Accept button. 

3. The dialog box through which you choose the components to be installed on your Personal Web 
Server will appear, as shown in Figure 2.8. It is recommended that you click the Typical button. 
This configuration includes all of the minimum components, plus basic documentation and 
additional components that will allow you to build and deploy Web applications.   

4. After you click on the Typical button, the dialog box with the default Web publishing home 
directory in the WWW Service field will appear. If you wish to install the default directory as your 
home directory, click the Next button.  

5. The Completing Installation dialog box will appear. When the installation has been completed, 
the final dialog box will appear. Installation of a Personal Web Server for Windows NT is 
complete. Click the Finish button to close out of the installation process.   

 

Figure 2.8. Choosing the Components To Be Installed on Your Personal Web Server 

Installing ProcessView 
Before installing WebHMI, you must have a licensed ProcessView installed on the designated 
WebHMI server machines.   

System Requirements 
To use the ProcessView software, you must have the following minimum system requirements: 

• 8X Speed CD-ROM 

• A minimum of 300 MB disk space available for installing the default ProcessView software. 
(Note: Actual amount required may decrease if help and example files are not installed. Project 
requirements for logging data, alarms and screen storage are above this minimum.) 

• VGA Video Card; 256 or more colors for best results. 

• Microsoft Internet Explorer 5.5 and above. 

• Microsoft Data Access Components (MDAC) 2.7 

• Microsoft Windows 98 SE, Windows 2000 with Service Pack 3, Windows Millennium (ME), or 
Windows XP with Service Pack 1, or Windows NT® 4.0 with Service Pack 6a 
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Note 

Windows 98 SE is supported only by the non-Unicode version of ProcessView. Minimum computer 
CPU and RAM requirements depend on the application and operating system, as shown in the 
following table. 

 

Application Size Processor RAM 

Small 
Windows 98 SE/NT Workstation/ME, 2000, 
XP 

 
233 MHz 
400 MHz 

 
64 MB 
128 MB 

Medium 

Windows 98 SE /NT/ME 
 , 2000, XP  

 
400 MHz 

650 MHz 

 
128 MB 

256 MB 

Large 

All Operating Systems 
 
1.8 GHz 

 

512 MB - 1GB 

 
The actual amount of RAM and/or processor speed will vary depending upon the I/O counts, 
networking, logging and alarming requirements, as well as other factors.  To determine which type 
of computer best fits your application, set up a test application station. 

Note 
The processor and memory requirements of your existing project may be greater in this version of 
ProcessView than in previous versions due to additional and enhanced features in the product. 

Installation Steps for ProcessView 
The following steps detail the ProcessView system installation. Before installing Smar software, be 
sure to close all other applications. For complete information with installation screens, please see 
the Getting Started Help documentation on the ProcessView product CD. 

Note 
If your operating system (e.g., Windows NT) requires a login name, you must log in with 
administrator capability before installing ProcessView software. 

 

1. Before installing Smar software be sure that all other applications, are closed and/or disabled. 
2. Insert the ProcessView product CD into your CD-ROM drive.  If "Autorun" is enabled on your 

system, the CD introduction starts automatically.  Otherwise, browse to your CD-ROM drive and 
run the "RunMe.bat" file.  

3. During the ProcessView 7.0 installation, the system will look for a prior installation of the 
ProcessView License Utility. If a pre-existing installation of the License Utility is detected, an 
update is required. If your PC is currently licensed, a temporary 7.0 license with the current 
configuration can be immediately granted for a 30-day temporary period. All current options and 
licensing information will be retained for 30-days. Please contact Smar for a license upgrade 
within the temporary 30-day period. 

Note 
ProcessView version 5.x and 6.x software licenses must be upgraded to work with 
ProcessView version 7.0 or subsequent versions of ProcessView. 

 

4. You will see the CD introduction and the main menu. From here you can also click on a link to 
the Smar Web site, go to the Documentation Center, view CD-based Web pages containing 
miscellaneous Information, and install software.  

5. Click on the ProcessView button. The Setup screen briefly appears, followed by the Welcome 
Message screen. Click the Next button to continue. 

6. The Software License Agreement dialog box appears. Read the License Agreement. Click Yes 
if you accept the terms of the agreement. 

7. The User Information dialog box appears. Enter your name in the Name field and your 
company information in the Company field. Click Next. 
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8. The Security Password dialog box appears. Type Smar (upper case) as the security password. 
This password will be used by the Security Server as the default administration password. Then 
click the Next button to continue. 

Important Note 
Be sure to remember this password! It is required when you first attempt to log in to the Security 
Configurator tool to set up security for your system.  Details on using the Security Configurator are 
covered later in this manual. The important point here is to make sure you remember what is 
entered in this field during installation. 

 

9. The Choose Destination Location dialog box appears. Choose the destination location for the 
software installation. The default directory for the setup is Program Files\Smar\ ProcessView. If 
you wish to keep this default location, click the Next button. If you prefer to select a different 
directory location for the installation, click the Browse button to select a different drive or 
directory. Click Next to continue. 

10. The Component dialog box appears. By default, the components and subcomponents installed 
by ProcessView require approximately 300 MB of disk space. If you lack the space, a message 
appears asking you either to change hard drives or delete unnecessary files from your current 
drive.  

There are subcomponents installed in many of the components. These subcomponents are typically 
broken into three subsections: program files, help files, and example files. If you do not have enough 
disk space to install the complete set of tools, you can elect either not to install one or more of the 
main components (e.g., DataWorX) or some of the subcomponents (e.g., help files).  If you only 
install the program files, for example, the hard disk space required decreases. To make a change, 
highlight the component and click the Change button.  This will open the Subcomponents dialog 
box for that component.  A check indicates that the component (or subcomponent) will be installed. 
Click Next to continue. 

11. The Select Components dialog box appears. Here there are two additional options available for 
a ProcessView  installation: 

• Browser Station Installation. This option should be used when installing the software on a 
networked PC that ties into another ProcessView  system.  A "Browser Station," which 
cannot connect directly to an OPC server, must connect to a remote machine. For a typical 
installation, this option should NOT be checked.  

• GraphWorX32 Runtime Only. This option creates an installation whereby GraphWorX (the 
graphics screen-building module in ProcessView ) cannot enter Configuration mode. For 
the typical installation, this option should NOT be checked. Click Next to continue. 

12. The Select Program Folder dialog box appears. You can choose in which program folder the 
software will be installed. The default folder in the Program Folder field is Smar ProcessView . 
You can keep this default, select an existing folder from the list, or type a new folder name in the 
Program Folders field. Click Next to continue. 

13. The copying of files will now begin. Click Cancel to stop the installation procedure at any time.  

Note 
The ProcessView installation automatically installs Microsoft Visual Basic for Applications (VBA). If 
you are using the Unicode version of ProcessView for international language-switching capability, 
the installation will give you the option of installing Microsoft Arial Unicode Font. 

Installing the ProcessView License Utility 
You must install and run the Smar Software Licensing before you can run ProcessView software in 
Windows in non-demo mode. A Software License Site Key will be generated to handle licensing of 
ProcessView without requiring a hardware protection key. Licensing encrypting information is stored 
deep within the Windows systems.  See the section below for further details on activating the 
license. This section first details how to install the software from the CD.  
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Note 

Set the System Date and Time properly before installing the Software License Utility. Setting the 
time and/or date by more than an hour after the installation will affect any time-limited Licenses 
(such as the Temporary 30-day Activation). 

 

Note 

If your operating system (e.g., Windows NT) requires a login name, you must log in as 
"Administrator" before installing the ProcessView  Software Licensing. 

 
If you are installing the License Utility program as a continuation of the ProcessView  installation 
covered in the previous chapter, skip to Step 4 below. For complete information with installation 
screens, please see the Getting Started Help documentation on the ProcessView product CD. 

1. Before installing Smar software, be sure that all other applications, such as Microsoft Office or 
any antivirus software, are closed and/or disabled. 

2. Insert the ProcessView product CD into the CD-ROM drive. 
3. You will see the CD introduction and the main menu. (If Autorun is enabled on your system, the 

CD introduction starts automatically. Otherwise, browse to your CD drive and run the 
"RunMe.bat" file. Select Software from the menu. 

4. Select Licensing from the software selection menu. 
5. The Software License installation starts and displays a Welcome screen. Click Next to continue. 
6. If you have a previous version of the ProcessView  License Utility installed, a notice appears. By 

installing the ProcessView 7.0 License Utility, you will no longer be able to run the 5.x and 6.x 
versions of ProcessView. If you have an existing Site Key for 5.x or a 6.x, a temporary 30-day 
license will be authorized for ProcessView 7.0. Click Yes to continue. 

7. In order to proceed with the License Utility installation, you must acknowledge that you have 
read the version compatibility notice that was displayed in the previous screen. Check the check 
box and click the Next button to continue. 

8. The Software License Agreement appears. If you accept the terms of the agreement, click 
Yes. 

9. The User Information dialog box appears. Type in your name and your company's name, and 
then click Next. 

10. Choose the destination directory for the installation. This defaults to \Program 
Files\Smar\SoftLic. If you want to install the License Utility in a different directory, click Browse. 
Click Next to continue. 

11. The setup will also create a program folder and copy all the shortcuts related to the License 
Utility into that program folder. The default program folder is Smar Software Licensing. You 
can specify a different folder if you want. Click Next to continue. The setup will start copying files 
to your computer and will display the status associated with the memory, disk space, and 
percentage of information copied. 

12. A notice appears, stating that the 30-day temporary license must be activated to provide a Site 
Code in order to obtain a valid Site Key. Click Yes to continue. 

13. In order to complete the License Utility installation, you must acknowledge that you have read 
the notice that was displayed in the previous screen. Check the check box and click the Next 
button to continue. 

14. Setup is now complete. Click the Finish button to exit the installation wizard. You may be asked 
to restart your computer before running the Smar License Utility.  

 

Note 
You must now run the License Utility and register your software license in order to use 
ProcessView  or any of its components. For more information, see the ProcessView Software 
Licensing documentation on the ProcessView product CD. 
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Installing WebHMI 
This section describes the steps for installing Smar WebHMI. Be sure to close any other 
applications before installing WebHMI. 

Note 
WebHMI version 7.0 currently does not support Netscape Navigator 7.0. 

 
1. To install WebHMI from the ProcessView Product CD, select WebHMI from the software 

installation menu. 

2. As you begin installing WebHMI on a properly configured PC, a Welcome dialog box will 
appear, as shown in Figure 2.9. Click Next to continue the installation.  

 

 

Figure 2.9. Welcome Screen 
 

3. The Smar WebHMI License Agreement dialog box will appear, as shown in Figure 2.10. 
Carefully read the Smar License Agreement.  If you agree with the terms and conditions, click 
Yes to continue.   
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Figure 2.10. License Agreement 

 

4. The Smar WebHMI Copyright dialog box will appear, as shown in Figure 2.11. After reviewing 
the copyright information, click Next to continue.  

 

Figure 2.11. Copyright Notice 
 
5. The User Information dialog box will appear, as shown in Figure 2.12. Type your (the user's) 

name in the Name field; your company's name in the Company field; and your WebHMI 
product's serial number in the Serial field.  Click the Next button to continue. 
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Figure 2.12. User Information Dialog Box 
 
6. The Installation Destination dialog box will appear, as shown in Figure 2.13. The default 

location is "C:\inetpub\wwwroot\WebHMI."  If you have installed or activated Microsoft Internet 
Information Server and used its default for installation locations, this default setting creates a 
WebHMI folder in your root www directory.  This location allows a client PC to access WebHMI 
files at "http://<Web address of Server>\WebHMI\."  

If your shared root directory is not the default supplied, click on the Browse button and choose the 
appropriate installation folder. After you have chosen a location, click OK. 

 

Figure 2.13. Choosing Your Installation Location 
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7. The Setup Type dialog box will appear, as shown in Figure 2.14. Choose Typical, Compact, 
or Custom installation.  Typical installs all WebHMI components. Compact installs no sample 
pages. Custom lets you select the specific components to be installed. After making your choice, 
click the Next button to continue. 

 
Figure 2.14. Choosing the Installation Type 

8. The Choose Communication Type dialog box will appear, as shown in Figure 2.15. Choose 
GenBroker over TCP (OPC over TCP), GenBroker over DCOM, or Standard OPC for 
installation.   

 
Figure 2.15. Choosing a Communication Type 
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Since the default communication type is GenBroker over TCP (OPC over TCP), it is recommended 
that you use it to install WebHMI server. If desired, you will then be able to change the settings at 
any time. GenBroker over TCP (OPC over TCP) is easy to use on a local area network (LAN), over 
an intranet or the Internet, and communicates through routers and firewalls. Of these three 
communication types, only GenBroker over TCP communicates over the Internet. For information 
about configuring TCP/IP and SOAP/XML channels, please see the GenBroker Help 
documentation.  

GenBroker over DCOM is recommended for use on a local area network where you know that all 
nodes have been properly set up. It is also recommended for use if you wish to avoid connecting 
over the Internet because you are uncertain of how all nodes in a network have been set up.  

Note 
GenBroker over DCOM works only in an environment where Microsoft Network has been installed. 
If you wish to communicate over the Internet, install GenBroker over TCP. 

 

Standard OPC is the legacy communication method used by ProcessView 5.x and 6.0. It is easy to 
use on local area networks. This is the default method for ProcessView applications. 

Note 
Standard OPC works only in an environment where Microsoft Network has been installed. If you 
wish to communicate over the Internet, install GenBroker over TCP. 

 

After you have chosen the communication type that you prefer, click Next. The Select Program 
Folder dialog box will appear, as shown in Figure 2.16.  

 

Figure 2.16. Select Program Folder 

Either type the name of a new program folder in the Program Folders field or select the program 
folder of your choice from the list in the pane below. Click the Next button.  

Note 
If you wish to change your choice of communication types, it is recommended that you uninstall 
WebHMI and perform the installation again from the beginning. 

 

9. The Copying System Files window will appear. While the system files are being automatically 
copied, the percentage of the files already copied will appear in the window's progress bar. 
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10. After all of the necessary system files have been copied, a dialog box will appear, as shown in 
Figure 2.17. Enter the name of your WebHMI server or select a local machine name. Customize 
your application by selecting one of three choices under Name Convention: 
• Microsoft Network. This is the name of the WebHMI server machine located on your local 

network. This is recommended with DHCP. 
• DNS (Domain Network Service). This is your registered domain name, such as 

www.myserver.com. 

• IP Address. The numeric IP address, such as 99.99.99.99 will automatically appear in the 
DNS Name field. 

 

After you have customized your application, click the OK button. 

 

Figure 2.17. Specifying the WebHMI Server Host Name 

11. The Setup Complete dialog box will appear. Click the Finish button to complete the setup. 

 

You have successfully completed installation of WebHMI on your computer. 
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Chapter 3 

3.1 

VIEWING WEBHMI SAMPLES 
Introduction to WebHMI Samples 

The WebHMI installation includes a series of sample screens, which get installed in the 
Inetpub\wwwroot\WebHMI\Samples directory. To access the Samples, select Start > Programs > 
ProcessView WebHMI > WebHMI Examples. The WebHMI Samples Home Page will appear, as 
shown in Figure 3.1. This page allows you to access both default (basic) and advanced WebHMI 
samples, as well as industry examples.  

Note 
When navigating the displays, you can click on the House icon at the top right of the screen to 
return to the home page at any time. 

 

 
Figure 3.1. WebHMI Samples Home Page 

Default Samples 
Clicking Default Samples on the WebHMI Samples Home page opens the WebHMI Default 
Samples page, shown in Figure 3.2.   

Click on the back arrow button at the bottom left at any time to move back to the previous display. 
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Figure 3.2. WebHMI Default Samples Page 

GraphWorX Samples 
Click on the GraphWorX link on the left-hand side of the home page. The GraphWorX sample page 
will appear, as shown in Figure 3.3.  

 
Figure 3.3. GraphWorX Sample Page 
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AlarmWorX Samples 
Return to the Default Samples page and click on the AlarmWorX link. The AlarmWorX sample 
page will appear, as shown in Figure 3.4. This contains example screens for the Alarm Viewer 
ActiveX, the Alarm Report ActiveX, and an Alarm Chart. You can move the mouse pointer over the 
alarms in the display to show ToolTips for the alarms, which provide information about each alarm.  

Note 
You must have MSDE installed to view the Alarm Report and Alarm Chart samples. 

 
Figure 3.4. AlarmWorX Samples Page 

TrendWorX Samples 
Return to the Default Samples page and click on the TrendWorX button. The TrendWorX sample 
page will appear, as shown in Figure 3.5. Here you can view various trend displays with trend pens 
in runtime mode, including a Time Plot, a Log Plot, a Strip Chart, a Circular Chart, and an XY plot. 
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Figure 3.5. TrendWorX Sample Pages 

ActiveX Control Samples 
Return to the Default Samples page and click on the ActiveX button. The ActiveX sample page will 
appear, as shown in Figure 3.6. To view various types of Smar ActiveX controls in action, including 
the Switch, Slider, Vessel, Gauge, and Numeric ActiveX controls, click on the buttons.   
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Figure 3.6. ActiveX Controls Samples 

Licensing and Security Samples 
The WebHMI Default Samples page also contains links to the Licensing and Security sample 
pages. For information on Security and Licensing, please see Chapter 6 and Chapter 7, 
respectively. 

Advanced Samples 
Return to the WebHMI Samples Home page and click on the Advanced Samples button, as shown 
in Figure 3.7.  
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Figure 3.7. WebHMI Samples Home Page 

This opens the Advanced Samples page, shown in Figure 3.8. The Advanced Samples page 
contains two buttons: Remote Connection and Advanced Scripting. 

 
Figure 3.8. Advanced Samples Page 

The Remote Connection samples page, shown in Figure 3.9, contains examples of complex 
GraphWorX display (.gdf) files that have been published as HTML pages through WebHMI. You can 
view these display files in real time over your WebHMI server. The examples include a bar graph, an 
Alarm Viewer, and a Trend Viewer. 
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Figure 3.9. Remote Connection Page 

The Advanced Scripting samples page, shown in Figure 3.10, contains examples of the use of 
VBScript in GraphWorX displays. For more information about the GraphWorX scripting engine, 
please see the GraphWorX Help documentation. 

 
Figure 3.10. Advanced Scripting Page 
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Industry Samples 
Return to the WebHMI Samples Home page and click on the Industry Samples button. This opens 
the Industry Samples page, shown in Figure 3.11, which contains example GraphWorX displays for 
various segments of the automation industry. 

 
Figure 3.11. Industry Samples Page 

 

 



Chapter 4 

4.1 

WEB PUBLISHING WIZARD 
Introduction to HTML Publishing 

The ProcessView Web Publishing Wizard enables you to "export" your GraphWorX (.gdf), 
TrendWorX (.t32), and AlarmWorX (.a32) displays to HTML files and/or publish the HTML files to a 
Web server (LAN or Internet). In publishing displays to a Web server, WebHMI uses HTML to 
reference the files in an Internet-enabled format. Once a display is "exported" to an HTML file and 
then published to a Web server, client machines can browse it through an Internet browser, such as 
Microsoft Internet Explorer or Netscape Navigator. Each display can be viewed as a Web page. 

Note 
Netscape Navigator generally does not support ActiveX technology. Smar has solved this problem 
by supplementing Netscape with a plug-in. Acting as a bridge, this plug-in allows for an ActiveX 
component to be put into the special Netscape module.  

Basic Steps in Publishing GraphWorX Displays  
Publishing a GraphWorX display to HTML involves the following basic steps: 

1. Create a GraphWorX display (.gdf) file on a developer workstation with GraphWorX installed. 

2. Use the Web Publishing Wizard to generate an HTML file and publish the file to a Web server 
(URL) address.  

3. On the Web server PC (with ProcessView installed), start GenBroker Server from GenTray. 

4. On a client PC, open a Web browser, such as Microsoft Internet Explorer, and browse to the 
URL address of the HTML file. The client PC downloads the HTML file from the Web server. The 
Web server delivers all the necessary components (e.g. ActiveX controls) to the client PC's Web 
browser, which then runs the GraphWorX display directly within the browser. This way you can 
view the GraphWorX display in real time as a Web page. 

The source code of the published HTML file contains references to the required “plug-ins” that are 
needed to deliver the GraphWorX Viewer ActiveX control to the client. The GraphWorX Viewer 
ActiveX is needed to run the .gdf file over the network. The GraphWorX display itself is not really 
“converted” into HTML. Instead the display (.gdf) file is referenced in the HTML code by the ActiveX 
plug-in.  

To expand on step 2 above, the following Microsoft Internet Explorer example shows the portion of 
the generated HTML source code that references the .gdf file.  The GWXview32.cab file is 
referenced in the codeBase field to deliver the “plug-in” for the GraphWorX Viewer ActiveX.  This in 
turn opens up the .gdf display.  In the example below, the .gdf display file is called Building1.gdf, 
as shown below in the DisplayName parameter field. 

<OBJECT classid=clsid:98A5DDE3-563B-11CF-A343-487C03C10000  
codeBase="http://www.myserver.com/webhmi/cabs/GWXview32.cab"  
id=GWXview321 style="HEIGHT: 420px; WIDTH: 620px" height=420 width=620> 
<param name="_Version" value="65537"> 
<param name="_ExtentX" value="16404"> 
<param name="_ExtentY" value="11113"> 
<param name="_StockProps" value="160"> 
<param name="BorderStyle" value="1"> 
<param name="Appearance" value="1"> 
<param name="DisplayName" value="http://www.myserver.com/webhmi/Building1.gdf"> 
<param name="UseAmbientBackColor" value="0"> 
<param name="AutoStartRuntime" value="-1"> 
<param name="OverrideScrollbarSettings" value="1"> 
<param name="VerticalScrollbar" value="0"> 
<param name="HorizontalScrollbar" value="0"> 
</OBJECT> 
Exporting a .gdf file to an HTML file not only references the GWXview32.cab file, as shown in the 
example above, but also references any other "plug-in" .cab files required for other ActiveX 
components that may be embedded within the .gdf file (e.g., TrendWorX or AlarmWorX Viewer 
ActiveX controls). 
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However, before a .gdf file can communicate with live OPC data, the IcoSetServer.cab file “plug-
in,” which is necessary for security and licensing, as well as a GenBroker configuration (.gbc or 
.gbx) file, which contains network configuration settings for OPC communications, must also be 
delivered to the client PC. The IcoSetServer.cab file and the .gbc or .gbx file are referenced in the 
HTML source code. This way the security and licensing information are available whenever a 
component (such as an Alarm Viewer ActiveX) is downloaded. The sample HTML source code 
below shows how these files are referenced in the code.  

<object id="SetServer2" classid="clsid:57802C16-9A15-11D4-B2A8-0090272E599B" 
codeBase=http://www.myserver.com/WebHMI/cabs/IcoSetServer.cab height=28 width=17> 
    <PARAM NAME="CfgName" 
VALUE="http://www.myserver.com/WebHMI/Samples/Default.gbc"> 
</object> 

The ProcessView Web Publishing Wizard in GraphWorX takes care of all the necessary HTML code 
references automatically. Microsoft Internet Explorer uses .cab files, whereas Netscape Navigator 
uses .dpl files. 

Note 
If you are using multiple frames for your WebHMI pages (e.g. a main "navigation" frame for 
browsing between pages, and a "content" frame that contains the body of the pages), make sure 
that the IcoSetServer.cab file and the .gbc or .gbx file are properly referenced in the HTML source 
code for the main frame. This way the security and licensing information are available whenever a 
component is downloaded. 

Delivering the Necessary Web Components to the Client 
WebHMI is designed to operate with Zero Install and Thin Client philosophy. This means the client 
PC has nothing but Windows, Internet Explorer, or Netscape loaded. Thus, all necessary Web 
components must be remotely delivered and seamlessly installed. The type and number of 
components required for delivery on the client PC are determined by the content of the GraphWorX 
displays.  For instance, a display with an embedded Trend Viewer requires delivery of the 
corresponding TrendWorX Viewer ActiveX Web component, but not the AlarmWorX Viewer ActiveX. 
On the other hand, a display with an embedded Alarm Viewer requires the corresponding 
AlarmWorX Viewer ActiveX but not the TrendWorX Viewer ActiveX. 

The delivery process can be very slow in terms of network speed. To avoid wasting time, the first 
requirement is to deliver only the required component. The delivery process is strictly connected to 
the HTML code. Inside the HTML code, there are references to .dpl files or .cab files, the basic ways 
to deliver components. As a result, the building of the HTML page is a critical step. The Web 
Publishing Wizard looks inside the display to understand what components are needed on the client 
side and then builds the corresponding HTML code. 

Netscape Navigator and Microsoft Internet Explorer neither process the HTML code in the same 
way nor deliver the component in the same standard format.  Basically, Microsoft Internet Explorer 
requires components to be delivered using .cab file technology whereas Netscape Navigator 
requires .dpl files. 

Client Station Requirement 

In order to view a published GraphWorX display, a client PC must have a Web browser installed 
(e.g. Microsoft Internet Explorer or Netscape Navigator). 

Developer Station Requirement 

The developer station requires GraphWorX Version 6.1 or greater. 

Web Server Station Requirement 

The Web server PC must have the following installed: 

• WebHMI 
• ProcessView (with GenBroker) 
• For Windows NT, Internet Information Server (IIS) or a Personal Web Server 
• For Windows 2000 and Windows XP, Internet Information Server (IIS) 
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Multiple Display Support 
Suppose that you have a main GraphWorX display (.gdf) file that is linked to other display files (e.g. 
each display contains pick actions, such as Load Display or Pop-up Window, that point to the other 
display files). When you publish the main display to an HTML file, you want all the links and 
references to the other dependent display files to be functional when the HTML file is downloaded to 
a client Web browser. The Web Publishing Wizard makes this possible by detecting all mutually 
linked display files, looping through all dynamic actions, and checking for pick actions in which a file 
name is specified as one of its parameters. The following pick actions are supported for multiple 
GraphWorX display Web publishing support: 

• Load Display 
• Embedded Window 
• Popup Window 
• Drag/Drop Load 
• Set Aliases 
• Alias Dialog (alias files specified through the Set Aliases dialog box in GraphWorX). 
 

The LoadTabs display property is also supported for publishing multiple GraphWorX displays. 

Embedded ActiveX Control Support 
In dealing with a main GraphWorX display (.gdf) file that is linked to other display files (as described 
in the "Multiple Display Support" section above), suppose you included an ActiveX Control (e.g. 
Alarm Viewer ActiveX or Trend Viewer ActiveX) into each of the dependent display files. Also 
suppose that you generated and published an HTML file only from the main display, but you want 
this single HTML file to trigger the simultaneous download and installation of all ActiveX Controls 
embedded within all interlinked GraphWorX display files. The Web Publishing Wizard's embedded 
ActiveX Control support makes this possible, allowing you to view the ActiveX Controls in all 
displays from a single client Web browser. 

Using the Web Publishing Wizard 
The Web Publishing Wizard performs two basic operations: 

1. The Wizard creates an HTML file based on a user-specified GraphWorX display (.gdf) file, 
TrendWorX display (.t32) file, or AlarmWorX display (.a32 file). 

2. The Wizard then either "exports" (saves) the HTML file to a user-specified directory on the local 
drive and/or "publishes" (uploads) the HTML file to a user-specified Web server URL address 
(i.e. over the Internet or an intranet). 

Starting the Web Publishing Wizard 
To launch the Web Publishing Wizard in GraphWorX:  

1. Load or create a GraphWorX display (.gdf) file. 

2. After you have either created a new display file or opened an existing file, select Save As from 
the File menu. The Save As dialog box opens, allowing you to specify the name and location of 
the file you are about to save. Type a name for the new file in the File Name field.  It is important 
that, when saving your file, you select "GraphWorX Displays without VBA (*.gdf)" in the Save as 
Type field, as shown in Figure 4.1, because the Web Publishing Wizard does not support 
Microsoft Visual Basic for Applications (VBA). Click the Save button to save the current file. 
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Figure 4.1. Saving the Display As a Non-VBA File 

3. Select Publish to HTML from the Tools menu, as shown in Figure 4.2. 

 
Figure 4.2. Starting the Web Publishing Wizard in GraphWorX 

Note 
If you try to run the Web Publishing Wizard with a GraphWorX display with VBA, you will get a 
warning message as shown in Figure 4.3. If you click Yes, the Web Publishing Wizard 
automatically saves the display as a non-VBA file. If you click No, the publishing operation is 
cancelled. 

 

 
Figure 4.3. Warning Message About Displays With VBA 
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4. This launches the Web Publishing Wizard configuration dialog box, as shown in Figure 4.4. 
This dialog box serves as the interface through which you export/publish GraphWorX display 
files to the Web. 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

 

 
Figure 4.4. Web Publishing Wizard Dialog Box 

Exporting a Display File Locally 
To export a GraphWorX display to a directory on the local drive: 

1. In the Based on Source File field of the Web Publishing Wizard, you must specify the name of 
the GraphWorX display (.gdf) file to be exported, as shown in Figure 4.5. To choose a different 
display, click the … button to the right to browse for a file. Select a file and then click Open. The 
directory path and the file name are shown in the text field.  
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Figure 4.5. Specifying a GraphWorX Display File 

2. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name.  

3. In the Publishing Options field, check the Export Local Copy check box and specify the local 
directory path name to which you want to export the HTML file. You can select a recently used 
path from the drop-down list, or click the … button to browse for a destination directory, as 
shown in Figure 4.6. Select the directory and click OK.  

 
Figure 4.6. Setting the Local Directory 

4. The local directory pathway you selected appears in the Export Local Copy field of the Web 
Publishing Wizard, as shown in Figure 4.7. 
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Figure 4.7. Export Local Copy Pathway Shown in the Wizard 

5. Click the OK button to generate the HTML file. The new HTML file is saved to the local directory 
pathway specified in the Export Local Copy field. 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

Publishing a Display File to a Web Server 
To publish the HTML file to a directory on a Web server (i.e. over the Internet or an intranet): 

1. In the Based on Source File field of the Web Publishing Wizard, you must specify the name of 
the GraphWorX display (.gdf) file to be published, as shown in Figure 4.8. To choose a different 
display, click the … button to the right to browse for a file. Select a file and then click Open. The 
directory path and the file name are shown in the text field. 
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Figure 4.8. Specifying a GraphWorX Display File 

2. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name.  

3. In the Publishing Options field, check the Publish to Web Server check box and type in the 
URL address of your Web server with the complete directory indicating where you want to 
publish the HTML file, as shown in Figure 4.9. In the sample Web server URL address shown 
below ("http://www.myserver.com/WebHMI/Samples"), the various components are: 

• http://www.myserver.com: IP address (server name) of the WebHMI Server 
• WebHMI: Name of the WebHMI server root directory  
• Samples: Name of the directory on the server to which the HTML file will be saved 

4. The Web server URL address now appears in the Web Publishing Wizard dialog box in the 
Publish to Web Server field of the Web Publishing Wizard, as shown in Figure 4.9. 
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Figure 4.9. Publish to Web Server Location Specified in Web Publishing Wizard 

5. Click the OK button to generate the HTML file. The new HTML file is uploaded to the Web 
server and then saved to the URL address path specified in the Publish to Web Server field. 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

Publishing Customization Options 
The Web Publishing Wizard contains some customization options for exporting/publishing HTML 
files. Clicking the Advanced button on the Web Publishing Wizard dialog opens the Web 
Publishing Properties dialog box, as shown in Figure 4.10, which contains the following tabs: 

• General Settings 
• Server Switching Support 
• Screen Resolution Settings 
• Publishing Options 

 
General Settings 

The General tab of the Web Publishing Properties dialog box, shown in Figure 4.10, allows you to 
specify the default URL address for the WebHMI Server. This WebHMI root URL path is used as the 
default path when only Export Local Copy is selected on the Web Publishing Wizard dialog box. (If 
Publish to Web Server is selected on the Web Publishing Wizard dialog box, you can specify a 
different URL path for the WebHMI Server.) 
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Figure 4.10. General Settings 

Server Switching Support 

The Server Switching Support tab of the Web Publishing Properties dialog box, shown in Figure 
4.11, allows you to enable or disable GenBroker support for the exported/published HTML file. Here 
you can specify which GenBroker configuration file (.gbc or .gbx) will be activated. The GenBroker 
configuration file establishes the settings for OPC data communications between the clients and the 
Web server.  

 
Figure 4.11.Server Switching Support Settings 

There are three available options for GenBroker support: 

• None: GenBroker support is not active. 
• As Configured in WebHMI Settings: This setting uses the default URL address of the 

GenBroker configuration (.gbc or .gbx) file as specified in the WebHMI installation. 
• User Defined: When this option is selected, the GenBroker Configuration File URL field 

becomes available, allowing you to specify the URL address of the GenBroker configuration 
(.gbc or .gbx) file.  

 



Web Publishing Wizard 

4.11 

Clients can receive data from different WebHMI servers, but communication can be established only 
to one server at a time. The server to which a client connects depends on the type of information 
that the client requests. If Server A, for example, does not contain the components necessary to 
answer the client's request, the request will be forwarded to Server B, or Server C, and so on. 

Note 
For information about configuring GenBroker settings, please see the GenBroker Configurator 
Help documentation. 

 

Screen Resolution Settings 

The Screen Resolution tab of the Web Publishing Properties dialog box, shown in Figure 4.12, 
determines the screen resolution and size of the GraphWorX Viewer ActiveX control, which is 
referenced in the generated HTML file and then downloaded to a client PC when the HTML file is 
viewed in the client's Web browser.  You can specify the screen size in the Width and Height fields 
in terms of pixels (px) or percentage (%). Click the Resolutions button to select from a pop-up 
menu of standard screen resolutions, as shown in Figure 4.12. 

 
Figure 4.12. Screen Resolution Settings 

Publishing Options 

The Publishing Options tab of the Web Publishing Properties dialog box, shown in Figure 4.13, 
enhances the publishing process. By default, the Web Publishing Wizard provides support for 
related files detection (for more details, see the Multiple Display Support section). The multiple 
display detection could be a rather lengthy process. You can speed up the process by disabling the 
Enable Multiple Display Support option. This is especially useful, if you have already published 
your project files to the Web server, and now you want to update display you have changed.  

The multiple display detection mechanism ensures that the Web page will be published properly for 
the source file. Disabling the Multiple Display Support may cause publishing of an incomplete web 
page, which may result in unexpected behavior. Therefore, it is suggested to disallow publishing of 
the Web page. You can do so by enabling the Publish Display File Only option. 
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Figure 4.13. Publishing Options 

Viewing Locally Exported HTML Files 
To view an HTML file that was exported to a local directory, simply browse to the local directory 
pathway and click on the file to open it in your Web browser. You can also open your Web browser 
and copy the directory pathway of the file into the Address field of the Web browser, as shown in 
Figure 4.14.. A complete directory path is, for example, "C:\Documents and 
Settings\Administrator\My Documents\Web Publishing Example\ChemFood_BeanRoaster.htm." Be 
sure to include the name of the HTML file that you have exported and the file extension "htm." 

 
Figure 4.14. Viewing the Exported HTML File in a Web Browser 

Viewing Published HTML Files 
Before a published HTML file can be downloaded from a WebHMI server, you must set GenBroker 
active on the WebHMI server node using GenTray: 

1. Launch GenTray from the Windows Start menu by selecting Programs > ProcessView  > 
Tools > GenTray. 

2. When GenTray opens, the triangle icon will appear in the Windows tool tray. Click on the triangle 
and select GenBroker > Start from the pop-up menu, as shown in Figure 4.15. This activates 
the GenBroker Server. 
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Figure 4.15. Starting the GenBroker Server on the Server Node 

3. Once the GenBroker Server is running, you can view the HTML file that you have published to 
the Web server from any client PC's Web browser. To view the published HTML file, open your Web 
browser and copy the URL address of the file into the Address field of the Web browser, as shown 
in Figure 4.16.  A complete address is, for example, 
"http://www.myserver.com/webhmi/Samples/ChemFood_BeanRoaster.htm." Be sure to include the 
name of the HTML file that you have published and the "htm" file extension. The GraphWorX display 
file is referenced in the HTML code so the display can be viewed as a Web page. The client's Web 
browser simply downloads the HTML file in which the .gdf file is referenced. All the client needs is a 
Web browser; it is not necessary to have ProcessView installed on client. The Web page is 
downloaded from the Web server across the Internet/intranet and appears in the client's Web 
browser window. The display is real-time, just as if you were viewing the runtime display in 
GraphWorX on the server machine; the OPC tag values change dynamically in the display. 

 
Figure 4.16. Viewing the Published HTML File in a Client Web Browser 

Web Publishing in ProjectWorX 
The Web Publishing Wizard can be accessed through ProjectWorX console, allowing you to easily 
export/publish one or more GraphWorX display files within a project to a Web server. As shown in 
Figure 4.17, the Applications/GraphWorX/Displays tree of each project includes an option to 
publish a single display or multiple displays in the project.  
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Figure 4.17. Publishing GraphWorX Displays From the ProjectWorX Console 

 

The WebHMI tree under the Applications tree for each project in the ProjectWorX console, shown 
in Figure 4.18, manages Web publishing for the entire project. From here you can right-click and 
publish HTML files to a Web server. The WebHMI tree includes the following three categories: 

• GraphWorX-Based HTML 
• Local HTML Files 
• Published Documents 

 

 
Figure 4.18. WebHMI Tree in ProjectWorX Console 
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GraphWorX-Based HTML 
The GraphWorX-Based HTML subtree of the WebHMI tree, shown in Figure 4.19, contains HTML 
files generated from exported GraphWorX displays. These HTML files have embedded code for 
accommodating a GraphWorX Viewer ActiveX Control.  Any requested local copy of a GraphWorX-
based HTML file generated from the Web Publishing Wizard is stored in this folder.  (See the “Web 
Publishing Wizard” section below for more information on exporting and publishing HTML files from 
GraphWorX displays.)  The ProjectWorX database maintains a record of which local GraphWorX 
display (.gdf) files each of these HTML files depends on.  Documents in this folder can be added, 
removed, copied, pasted, opened, edited, added to Microsoft Visual SourceSafe, searched, 
replaced, and packed the same way items from other categories can. 

 
Figure 4.19. GraphWorX-Based HTML Subtree 

Local HTML Files 
The Local HTML Files subtree of the WebHMI tree stores basic HTML files that were not generated 
from the Web Publishing Wizard.  Here you can add, delete, edit, and maintain various HTML files, 
as shown in Figure 4.20. 

 
Figure 4.20. Local HTML Files Subtree 

Published Documents 
The Published Documents subtree of the WebHMI tree, shown in Figure 4.21, maintains a list of 
all HTML files that have been exported/published from ProjectWorX.   

 
Figure 4.21. Published Documents Subtree 

 

In the right-hand pane of the ProjectWorX Console, each item is listed as a URL with the date it was 
published, as shown in Figure 4.22. For information about publishing files from ProjectWorX, please 
see "Using the Web Publishing Wizard." 

 
Figure 4.22. List of All Documents Published From ProjectWorX 



WebHMI  

4.16 

Launching the Web Publishing Wizard in ProjectWorX 
The Web Publishing Wizard in ProjectWorX, shown in Figure 4.23, performs two basic operations: 

1. The Wizard creates HTML files based user-specified GraphWorX display (.gdf) files. 

2. The Wizard then either "exports" (saves) the HTML files to a user-specified directory on the local 
drive and/ or "publishes" (uploads) the HTML file to a user-specified Web server URL address 
(i.e. over the Internet or an intranet). 

 
Figure 4.23. Web Publishing Wizard in ProjectWorX Console 

You can open the Web Publishing Wizard dialog from the ProjectWorX console in the following 
ways: 

Select the project root and then choose Publish Wizard from the Tools menu, as shown in Figure 
4.24. In this case, both the Publish Web Page field and the Based on Source File field in the Web 
Publishing Wizard dialog are read-only and contain the text “(Display Name).htm” and “(All 
GraphWorX Displays in Project),” respectively.  The browse (…) button is also disabled. 
 

 
Figure 4.24. Opening the Publishing Wizard From the Tools Menu 

• Right-click on the Applications/GraphWorX/Displays tree and select Publish All Displays, as 
shown in Figure 4.25. In this case, both the Publish Web Page field and the Based on Source 
File field in the Web Publishing Wizard dialog are read-only and contain the text “(Display 
Name).htm” and “(All GraphWorX Displays in Project),” respectively.  The browse (…) button is also 
disabled. 



Web Publishing Wizard 

4.17 

 

 
Figure 4.25. Publishing All GraphWorX Displays in a Project 

 
• Right-click on a GraphWorX display and select Publish HTML, as shown in Figure 4.26. In this 
case, the Based on Source field in the Web Publishing Wizard dialog is read-only and contains the 
name of the selected GraphWorX display.  The browse (…) button is also disabled. 

 

 
Figure 4.26. Publishing a GraphWorX Display File 

 
• Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New HTML 

Document, as shown in Figure 4.27. In this case, you need to specify a GraphWorX display file 
in the Based on Source File field by browsing for the file or by typing in the file name. You also 
need to specify the name of the new HTML file in the Publish Web Page field. 

 

 
Figure 4.27. Creating a New HTML File in a Project 
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Export and Publish Options in ProjectWorX 
The Web Publishing Wizard in the ProjectWorX console, shown in Figure 4.28, generates an HTML 
file based on one or more user-specified GraphWorX display (.gdf) files. Then the Wizard either 
"exports" (saves) the HTML file to a user-specified directory on the local drive or "publishes" 
(uploads) the HTML file to a user-specified Web server URL address (i.e. over the Internet or an 
intranet).  

You have the following options when using the Web Publishing Wizard for a project: 

• Export and/or publish all GraphWorX display files in the project. 
• Export and/or publish a single GraphWorX display file in the project. 
• Export a display file locally 
• Publish a display file to a Web server. 
 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

 

 
Figure 4.28. Web Publishing Wizard in ProjectWorX Console 

Exporting and Publishing Multiple GraphWorX Display Files in 
ProjectWorX 
In ProjectWorX, you can export and/or publish multiple GraphWorX display files using the Web 
Publishing Wizard. 

To export/publish all displays in a project: 

1. Select the project root and then choose Publish Wizard from the Tools menu, or right-click on 
the Applications/GraphWorX/Displays tree and select Publish All Displays, as shown in 
Figure 4.29. 
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Figure 4.29. Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in Figure 4.30. In this case, both the 
Publish Web Page field and the Based on Source File field in the Web Publishing Wizard 
dialog are read-only and contain the text “(Display Name).htm” and “(All GraphWorX Displays in 
Project),” respectively.  The browse (…) button is also disabled. 

 
Figure 4.30. Publishing All GraphWorX Displays in a Project 

Exporting and Publishing Individual GraphWorX Display Files in 
ProjectWorX 
In ProjectWorX, you can export and/or publish individual GraphWorX display files using the Web 
Publishing Wizard.  

To export/publish a single display in a project: 

1. Right-click on a GraphWorX display and select Publish HTML, as shown in Figure 4.31. 
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Figure 4.31. Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in Figure 4.32. In this case, the Based on 
Source File field in the Web Publishing Wizard dialog is read-only and contains the name of the 
selected GraphWorX display.  The browse (…) button is also disabled.  

3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name. 

 
Figure 4.32. Publishing a GraphWorX Display in a Project 

Note 
You can also right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select 
New HTML Document, as shown in Figure 4.33, to export/publish a GraphWorX display. This 
launches the Web Publishing Wizard. In this case, you need to specify a GraphWorX display file in 
the Based on Source File field by browsing for the file or by typing in the file name. You also need 
to specify the name of the new HTML file in the Publish Web Page field. 
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Figure 4.33. Creating a New HTML File in a Project 

Exporting a Display File Locally in ProjectWorX 
To export a GraphWorX display to a directory on the local drive: 

1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New HTML 
Document, as shown in Figure 4.34. 

 
Figure 4.34. Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in Figure 4.35. In the Based on Source 
File field of the Web Publishing Wizard, you must specify the name of the GraphWorX display 
(.gdf) file to be exported, as shown in Figure 4.35. To choose a display, click the … button to the 
right to browse for a file. Select a file and then click Open. The directory path and the file name 
are shown in the text field.  

 
Figure 4.35. Exporting a Display File Locally in ProjectWorX 
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3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created.  

4. In the Publishing Options field, the Export Local Copy check box is checked by default. 
Specify the local directory path name to which you want to export the HTML file. You can select 
a recently used path from the drop-down list, or click the … button to browse for a destination 
directory. Select the directory and click OK. The local directory pathway you selected appears in 
the Export Local Copy field of the Web Publishing Wizard. 

Note 
By default, ProjectWorX saves the HTML file to the (local) Applications/WebHMI/GraphWorX-
Based HTML tree. From there, the HTML file can be edited and published again in the future. 

5. Click the OK button to generate the HTML file. The new HTML file is saved to the local directory 
pathway specified in the Export Local Copy field. 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

Publishing a Display File to a Web Server in ProjectWorX 
To publish the HTML file to a directory on a Web server (i.e. over the Internet or an intranet): 

1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New HTML 
Document, as shown in Figure 4.36. 

 
Figure 4.36. Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in Figure 4.37.  In the Based on Source 
File field of the Web Publishing Wizard, you must specify the name of the GraphWorX display 
(.gdf) file to be published, as shown in Figure 4.37. To choose a display, click the … button to 
the right to browse for a file. Select a file and then click Open. The directory path and the file 
name are shown in the text field.  
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Figure 4.37. Publishing a Display File to a Web Server 

3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created.  

4. In the Publishing Options field, check the Publish to Web Server check box and type in the 
URL address of your Web server with the complete directory indicating where you want to 
publish the HTML file, as shown in Figure 4.37. In the sample Web server URL address shown 
above ("http://www.myserver.com/WebHMI/Samples"), the various components are: 

• http://www.myserver.com: IP address (server name) of the WebHMI Server 
• WebHMI: Name of the WebHMI server root directory  
• Samples: Name of the directory on the server to which the HTML file will be saved 

5. Click the OK button to generate the HTML file. The new HTML file is uploaded to the Web server 
and then saved to the URL address path specified in the Publish to Web Server field. 

Note 
By default, ProjectWorX also saves the HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. From there, the HTML file can be edited 
and published again in the future. 

 
Note 

Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

 

Publishing Customization Options 
The Web Publishing Wizard contains some customization options for exporting/publishing HTML 
files. Clicking the Advanced button on the Web Publishing Wizard dialog opens the Web 
Publishing Properties dialog box, which contains the following tabs: 

• General Settings 
• Server Switching Support 
• Screen Resolution Settings 
• Publishing Options 
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General Settings 

The General tab of the Web Publishing Properties dialog box, shown in Figure 4.38, allows you 
to specify the default URL address for the WebHMI Server. This WebHMI root URL path is used as 
the default path when only Export Local Copy is selected on the Web Publishing Wizard dialog 
box. (If Publish to Web Server is selected on the Web Publishing Wizard dialog box, you can 
specify a different URL path for the WebHMI Server.) 

 
Figure 4.38. General Settings 

 

Server Switching Support 

The Server Switching Support tab of the Web Publishing Properties dialog box, shown in Figure 
4.39, allows you to enable or disable GenBroker support for the exported/published HTML file. Here 
you can specify which GenBroker configuration file (.gbc or .gbx) will be activated. The GenBroker 
configuration file establishes the settings for OPC data communications between the clients and the 
Web server.  

 
Figure 4.39. Server Switching Support Settings 

There are three available options for GenBroker support: 

• None: GenBroker support is not active. 
• As Configured in WebHMI Settings: This setting uses the default URL address of the 

GenBroker configuration (.gbc) file as specified in the WebHMI installation. 
• User Defined: When this option is selected, the GenBroker Configuration File URL field 

becomes available, allowing you to specify the URL address of the GenBroker configuration 
(.gbc or .gbx) file.  
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Clients can receive data from different WebHMI servers, but communication can be established only 
to one server at a time. The server to which a client connects depends on the type of information 
that the client requests. If Server A, for example, does not contain the components necessary to 
answer the client's request, the request will be forwarded to Server B, or Server C, and so on. 

Note 
For information about configuring GenBroker settings, please see the GenBroker Configurator 
Help documentation. 

 
Screen Resolution Settings 

The Screen Resolution tab of the Web Publishing Properties dialog box, shown in Figure 4.40, 
determines the screen resolution and size of the GraphWorX Viewer ActiveX control, which is 
referenced in the generated HTML file and then downloaded to a client PC when the HTML file is 
viewed in the client's Web browser.  You can specify the screen size in the Width and Height fields 
in terms of pixels (px) or percentage (%). Click the Resolutions button to select from a pop-up 
menu of standard screen resolutions, as shown in Figure 4.40. 

 

 
Figure 4.40. Screen Resolution Settings 

 
Publishing Options 

The Publishing Options tab of the Web Publishing Properties dialog box, shown in Figure 4.41, 
enhances the publishing process. By default, the Web Publishing Wizard provides support for 
related files detection (for more details, see the Multiple Display Support section). The multiple 
display detection could be a rather lengthy process. You can speed up the process by disabling the 
Enable Multiple Display Support option. This is especially useful, if you have already published 
your project files to the Web server, and now you want to update display you have changed.  

The multiple display detection mechanism ensures that the Web page will be published properly for 
the source file. Disabling the Multiple Display Support may cause publishing of an incomplete web 
page, which may result in unexpected behavior. Therefore, it is suggested to disallow publishing of 
the Web page. You can do so by enabling the Publish Display File Only option. 
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Figure 4.41. Publishing Options 

Publishing Files at a Later Time 
The Web Publishing Wizard, ProjectWorX saves the generated HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. The advantage of storing a local copy of an 
exported HTML file is that it can be edited, packed, moved, unpacked, and then published again at 
any time. This saves you the burden of having to re-export the same GraphWorX display file to a 
new HTML file.  You can use this option in any of the following ways: 

• Right-click on any HTML file in the Applications/WebHMI/GraphWorX-Based HTML tree and 
select Publish HTML from the pop-up menu, as shown in Figure 4.42. 
• Right-click on any HTML file in the Applications/WebHMI/Local HTML Files tree and select 
Publish HTML from the pop-up menu.  
 

Note 
Selecting Edit HTML from the pop-up menu opens the source code for the HTML file. 

 

 
Figure 4.42. Publishing a Locally Stored HTML File 

• Right-click on the GraphWorX-Based HTML Files tree and select Publish All Files from the 
pop-up menu, as shown in Figure 4.43. 
• Right-click on the Local HTML Files tree and select Publish All Files from the pop-up menu. 
• Right-click on the WebHMI tree and select Publish All Files from the pop-up menu. This 
publishes all HTML files in the WebHMI tree. 
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Figure 4.43. Publishing All Locally Stored HTML Files 

 

All of these actions open the Publish HTML File to Web Site dialog box, as shown in Figure 4.44. 
The Qualified WWW Folder field in this dialog is identical to the Publish Location field in the Web 
Publishing Wizard dialog and is stored in the same place in the registry if the action is successful. 
This specifies the location of the Web server to which the HTML file will be published. If the 
export/publish action is successful, a "publish” action on an HTML file in the Local HTML Files tree 
simply uploads the HTML file to the Web server.  A “publish” action on an HTML file in the 
GraphWorX-Based HTML Files tree uploads both the HTML file and its attached GraphWorX 
display (.gdf) file to the Web server. 

 

 
Figure 4.44. Specifying a Web Server Location for HTML Publishing 

Web Publishing Log 
When exporting/publishing only one file from a GraphWorX display to HTML, you are alerted if 
anything goes wrong in the process.  If, however, multiple files are being exported/published 
simultaneously, a log is generated so the operation will not be halted with each file that cannot be 
exported/published.  After a batch publishing operation from the GraphWorX-Based HTML Files 
tree, a log file appears showing the success or failure of each attempt to publish the files.  If this log 
file is needed at a later time, it can be found in the project root, as shown in Figure 4.45. 

 
Figure 4.45. Location of Web Publishing Log File 
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Chapter 5 

5.1 

WEBHMI CLIENT CONFIGURATION 

WebHMI Client/Server Architecture 
GenBroker acts as a bridge that links WebHMI clients to the WebHMI server over the Internet. The 
WebHMI clients are used to view Web pages downloaded from the WebHMI server through a Web 
browser (Internet Explorer or Netscape Navigator). As shown in Figure 5.1, GenBroker enables 
communication between the Web clients and the WebHMI server over TCP/IP. 

Note 
For complete information about configuring GenBroker communications, please refer to the 
GenBroker Help documentation. 

 

 
Figure 5.1. WebHMI Client/Server Architecture 

Configuring GenBroker 
The GenBroker Configurator is a tool that enables you to customize your network architecture. The 
GenBroker Configurator allows you to: 

• Specify the communication method. 

• Configure the GenBroker Client. 

• Configure the GenBroker Server. 

• Assign nodes to direct channels. 

• Assign mediator nodes for indirect channels. 

• Specify the default channel. 

• Add and remove nodes or IP addresses. 

• Configure channel properties. 

• Specify the location of primary and redundant remote servers. 

The configuration settings are saved in a GenBroker configuration (.gbc or .gbx) file. You can store 
multiple configuration files. Configuration files tell GenBroker Server how to communicate when it 
interacts with various clients. The .gbx configuration file is the preferred format for version 7.0. The 
.gbc format only contains primary nodes of security and licensing servers, while .gbx contains the 
primary and backup nodes for all kinds of Smar servers. The .gbx file is stored in XML, while the 
.gbc is binary. The .gbc file is used for backward compatability with version 6.x. It is recommended 
that you use the .gbx format in version 7.0. 
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Note 

GenBroker has already been configured prior to installation. Configure (or reconfigure) 
GenBroker only if you wish, for example, to change servers. 

 
GenBroker is configured for both the client side and the server side. For WebHMI, the GenBroker 
configuration (.gbc or .gbx) file used by the client resides on the server side. Once the client 
connects to the server, the file is downloaded from the server. ProcessView clients have their own 
.gbc or .gbx file. Note that a GenBroker Server does not need to be a GenBroker client or a Web 
server. 

Note 
For complete information about configuring GenBroker communications and GenBroker Server, 
please refer to the GenBroker Help documentation. For information about WebHMI client 
configuration, please see the WebHMI help documentation. 

Configuring GenBroker for the Client Side 
GenBroker is configured for both the client side and the server side. Here we are concerned with 
WebHMI client configuration. For information on how to configure GenBroker for the server side, 
and for example GenBroker configurations, please see the GenBroker Help documentation.  

WebHMI uses a configuration (.gbc or .gbx) file for GenBroker. The GenBroker configuration file 
used by the client resides on the server side. Once the client connects to the server, the .gbc or .gbx 
file will be downloaded from the server.  

The first step in the WebHMI client configuration is to specify which .gbc or .gbx file to use. You can 
use a default file provided in the WebHMI installation, or you can you can create a new file. To work 
with a .gbc or .gbx file, you must start the WebHMI client configuration from the Windows Start 
menu by selecting Programs > WebHMI> Client Configuration, as shown in Figure 5.2. 

 

Figure 5.2. Starting the Client Configuration 

This opens the WebHMI tab of the GenBroker Properties dialog box, as shown in Figure 5.3. To 
use the default configuration file, click the ... button to the right of the GenBroker Configuration to 
Upload field. This allows you to select a .gbc file. Browse to "InetPub\wwwroot\WebHMI\Samples" 
and select Default.gbx.  
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Figure 5.3. WebHMI Client Configuration 

The file pathway will appear in the text box, as shown in Figure 5.3. You do not have to reconfigure 
the default file except to: 

• Redirect channels of a WebHMI server. 

• Add a channel for a new node whose resident OPC server provides data to client PC browsers. 

If you want to set up a different or more advanced client/server communication architecture, you can 
either reconfigure the “default.gbx” file or create a new .gbc or .gbx file.  

Editing the Default Configuration File 
To reconfigure the default configuration, click the Edit button on the WebHMI tab of the GenBroker 
Properties dialog box. This opens the GenBroker Configurator screen, shown in the example in 
Figure 5.4. Notice that the file pathway is displayed under the Configuration File field. In the 
example, the IP address "99.99.99.99" is the default mediator node and is the node assigned to the 
Security server and the License server. You can add, remove, or reconfigure nodes using the 
commands and functions described in the following sections. 

 

Figure 5.4. Editing the Default GenBroker Configuration 
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Creating a New GenBroker Configuration File 
You can also create a new configuration by clicking the New button on the WebHMI tab. This opens 
the GenBroker Configurator screen, shown in Figure 5.5. You can add and configure nodes using 
the commands and functions described in the GenBroker Help documentation. To view the 
GenBroker Help, select Help Topics from the Help menu. 

 

Figure 5.5. Creating a New GenBroker Configuration 

Retrieving a GenBroker Configuration File From a Web Page 
Alternatively, you can search for a GenBroker configuration file in an HTML file. In many cases, .gbc 
or .gbx files are referenced in the source code of HTML files. Click the ... button to the right of the 
Web Page (HTML File) field on the WebHMI tab of the GenBroker Properties dialog box. Browse 
to select an HTML file, and then click the Open button. The HTML file pathway will now be 
displayed in the Web Page (HTML File) text box. In addition, the Edit Source button will be 
enabled. Clicking Edit Source allows you to view the source code for the selected HTML file. Once 
you have selected the HTML file, click the Get From HTML button to retrieve the .gbc or .gbx file 
that is referenced in the HTML source code. 

Example GenBroker Configuration 
This section shows an example GenBroker configuration for the sample network setup shown in 
Figure 5.6. The network includes five different PCs, or nodes. The example GenBroker 
configuration shown here is for PC1, which communicates with PC2, PC3, PC4, and PC5 according 
to the settings in the GenBroker Configurator. This example demonstrates how communication 
between PC1 and the other four PCs can be routed through a mediator node, as shown in Figure 
5.6. PC1 will not communicate directly with the remote computers, but it instead will establish a 
connection with the mediator computer. This mediator will then route the communications to the final 
destinations—in this case PC2, PC3, PC4, or PC5. The mediator node may be located on a remote 
computer, which can only be reached through a RAS (remote access service) connection or the 
Internet. 
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Figure 5.6. Communication via Mediator Node 

Communication Using a Mediator Node 
The GenBroker configuration on the mediator node determines how the mediator will connect to 
PC2, PC3, PC4, and PC5. This may use OPC direct, OPC over DCOM, or OPC over TCP/IP. In this 
case, OPC direct is the default method of communication. To configure communication through the 
mediator node on a TCP/IP channel, for example, do the following: 

1. Select Add TCP/IP Channel from the Channel menu. This opens the Select a Node dialog box. 
Specify a name for the mediator node (for example, "Mediator") in the Node Name or IP 
Address field, and then click OK. The new channel will appear in the GenBroker Configurator 
screen as OPC over TCP/IP Channel via Mediator, and the new mediator node will appear 
below the new channel, as shown in Figure 5.7. 

2. Now add PC2, PC3, PC4, and PC5 to the new TCP/IP channel. Right-click OPC over TCP/IP 
Channel via Mediator and select Add Node from the pop-up menu. This opens the Select a 
Node dialog box. Enter PC2 in the Node Name or IP Address field, and then click OK. The 
node name will appear below the channel, as shown in Figure 5.7. Repeat this procedure for 
PC3, PC4, and PC5.  

Note 
For additional examples of GenBroker configurations, please see the GenBroker Help 
documentation by selecting Help Topics from the Help menu. 

 

 

Figure 5.7. Configuring a Mediator Node 
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Chapter 6 

6.1 

WEBHMI SECURITY 

WebHMI Security ActiveX 
An example of WebHMI Security is included in the WebHMI sample screens. To access the 
samples, select Start > Programs > WebHMI > WebHMI Examples. The WebHMI Samples Home 
Page appears, as shown in Figure 6.1.   

 
Figure 6.1. WebHMI Samples Home Page 

Click on Default Samples to open the WebHMI Default Samples page, as shown in Figure 6.2. 
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Figure 6.2. WebHMI Default Samples Page 

Click on the Security button to open the Security sample page shown in Figure 6.3. The Symbol 
Library in GraphWorX contains a symbol category file called "WebHMI Security Login.sdf," which 
contains several symbols that, when dragged into a GraphWorX display, allow users to gain access 
to the Security Server.  

All the symbols use VBScript to call the Security Server on the remote WebHMI Server and get back 
security information. You do not need to know VBScript to use this symbol. You can directly drag 
and drop the symbol that you need from the Symbol Library into your display, but you also have the 
freedom to use the Script Editor toolbar in GraphWorX to change the source code associated with 
each of these symbols. Or you can copy the code and attach it to your own symbols. 

All of the scripts associated with these symbols create an instance of the “Smar Login ActiveX” and 
call methods of this object or access properties. The complete automation for the “Smar Login 
ActiveX” is described later in this chapter. 

These symbols are shown in Figure 6.3.   
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Figure 6.3. WebHMI Security ActiveX Symbols in GraphWorX 

Logging Into the Security Server 
The WebHMI Security Login ActiveX symbol button, shown in Figure 6.4, enables WebHMI users 
on remote client machines to log in to the Security Server. For example, if the "Login" symbol button 
is placed in a GraphWorX display, the user can simply click on the symbol (button) in runtime mode 
to launch the Security Login dialog box, as shown in Figure 6.4.  

 

Figure 6.4. Security Login Symbol Button 

The Security Login dialog is basically the same as the one for the Security Login Utility, except that 
the Advanced login mode is disabled, as shown in the Figure 6.5. The WebHMI Security Login 
ActiveX also includes full keypad support (ideal for touch-screen systems). The Login ActiveX allows 
simultaneous login of many users (this must be enabled on the Security Server global settings).  

The drop-down list for the user name can show: 

• The complete list of users in the system. 

• The list of the currently logged users. 

• The name of the last logged user. 

All of these features must be enabled on the Security Server in order to work. 

For more information, please see the Security Configurator Help documentation. 



WebHMI  

6.4 

 
Note 

When you log into the Security Server using the Login ActiveX, you do not get any warning 
messages when the security session is about to expire. If your security session expires, then the 
Login ActiveX will automatically be displayed again. 

 

 
Figure 6.5. Logging Into the Security Server 

Changing the Security Server Password 
If you should wish to change your password you can do it by clicking on the Change Password 
button on the login ActiveX dialog, or you can do it directly by using the Change Password symbol 
button and dragging it into your GraphWorX display, as shown in Figure 6.6.  

 
Figure 6.6. Change Password Button 

Clicking the Change Password button opens the Security Password Change dialog box, as 
shown in Figure 6.7. Type your new password in the New Password and Retype Password fields, 
and then click the OK button. 

 
Figure 6.7. Changing the Security Password  

Viewing the Logged User List 
To view a list of users currently logged in to the Security Server, click the Logged User List symbol 
button in your GraphWorX display, as shown in Figure 6.8. 

 
Figure 6.8. Logged Users List Button 

The Security window will appear, as shown in Figure 6.9. The Security window allows you to view 
the list of users that have logged in. 
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Figure 6.9. List of Logged Users 

Logging out of the Security Server 
To log out everyone who has logged in, you can use the Log Out All Users symbol button shown in 
Figure 6.10. 

 
Figure 6.10. Logout All Button 

You can also logout one specific user with a simple click on the Logout User button, as shown in 
Figure 6.11. 

 
Figure 6.11. Logout User Button 

Note 
You have to specify the user to be logged out in the VBScript code associated with this button. You 
can do it by editing the script with the Script Editor toolbar in GraphWorX. 

Security OLE Automation 
The OLE Automation interface for the WebHMI Security ActiveX is compatible with VBA and 
VBScript. You can perform login/logout operations directly trough scripting without displaying any 
user interface. The WebHMI Security ActiveX contains the following OLE Automation interfaces: 

 

LoginDlg()  

Launches the login dialog. 

 

ChangePwdDlg()  

Launches the dialog to change the password. 

 

ShowLoggedInUsers()  

Launches the dialog to show a list of the usesr currently logged into the Security Server. 

 

Logout()  

Logs out all currently logged users. 
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SetTimeout(LONG nSec)  

Sets the timeout for all of the GenClient calls to the Security Server. 

 

ShowResultMsgs(BOOL bShow)  

Enables / disables the message box with the result (e.g. "failed to log on to the Security Server"). 

 

LoginUser(BSTR username, BSTR password)  

Logs in one specific user through code. 

 

LogoutUser (BSTR username)  

Logs out a specific user through code. 
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7.1 

WEBHMI LICENSING 

Viewing Licensing Information Using WebHMI 
An example of WebHMI Licensing is included in the WebHMI Sample screens. To access the 
samples, select Start > Programs > Smar WebHMI > WebHMI Examples. The WebHMI Samples 
Home Page will appear, as shown in Figure 7.1.   

 
Figure 7.1. WebHMI Samples Home Page 

Click on Default Samples to open the WebHMI Default Samples page, as shown in Figure 7.2. 
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Figure 7.2. WebHMI Default Samples Page 

Clicking on the Licensing button opens the Licensing page, which allows you to launch the 
ProcessView License Monitor. The License Monitor allows you to get an immediate view of the 
number of Client Units your enterprise is using at a given time. Click the Show License button, as 
shown in Figure 7.3. 
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Figure 7.3. Launching the License Monitor 

 

This launches the License Monitor, shown in Figure 7.4, which provides information about the 
Client Units and points used to run specific ProcessView applications. The Client Units field lists the 
number of Client Units that are currently being used in all ProcessView applications, the number of 
Available Client Units (which are not currently in use), and the Total number of Client Units, which 
is equal to the number of available Client Units plus the number of Client Units In Use. For example, 
if you have 700 total Client Units and 300 Clients Units are currently being used, then 400 Client 
Units are available. Similarly, the Points field provides information about the number of process 
points that are currently being used (in runtime mode) in all ProcessView applications. 
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Figure 7.4. ProcessView License Monitor 

License for the WebHMI Server 
As mentioned in Chapter 2, before installing WebHMI you must have a licensed ProcessView 
installed on the designated WebHMI server. Likewise, the Smar Software License Utility must also 
be installed on the WebHMI server. 
Otherwise, the Software License Utility and its installation are the same for WebHMI as they are for 
any other Smar application. 

Obtaining Additional Connection Units 
If you desire additional units, you will need additional licensing for the WebHMI server. Additional 
units are provided in increments of five. To obtain additional units, contact Smar distributor. 
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CHANGE HOST UTILITY 

Introduction to the Change Host Utility 
At some point, you might find that you wish to switch Web servers or use an OPC server on a 
different node. The WebHMI Change Host Name Utility enables you to do this easily. To open the 
Change Host Utility from the Windows Start menu, select Programs > WebHMI > Change Host 
Name Utility. The Change Host Name dialog box will appear, as shown in Figure 8.1. 

Note 
The process of running the Change Host Utility may require several minutes, and during this time 
the circle associated with each file type shown in Figure 8.1 (on the right side) will change color. 
The circle will be red while processing a specific file type, and it will be green when the specific file 
type is completed with success. The screen may actually flash for an instant while the utility is 
"operating" on a file. It is possible to see the file currently processed by reading the file name in the 
bottom right part of the dialog. 

 

 
Figure 8.1. Change Host Name Dialog Box 

Changing the Directory Name 
Change the directory name by typing it in the Working Directory field, as shown in Figure 8.2. You 
can also change the directory name by clicking on the button to the right of the Working Directory 
field or by selecting Set Working Directory from the File menu. 

 

 
Figure 8.2. Directory Name 
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Finding and Replacing Files 
Functioning like any "find-and-replace" command, the Change Host Name dialog box searches 
Smar files for: 

• GWX: GraphWorX (.gdf) display files 

• TWX: TrendWorX (.v32) files 

• AWX: AlarmWorX Viewer (.awv) files 

• AWR: AlarmWorX Report (.awr) files 

• GenBroker: GenBroker configuration (.gbc or .gbx) files 

• HTML: .htm files 
Choose the type of file for which you want to search by clicking on the check boxes in the right 
column, as shown in Figure 8.1. The Change Host Name utility searches for the text typed in the 
Find what field and replaces it with the text typed in the Replace with field, as shown in Figure 8.3. 

 

 
Figure 8.3. Find What and Replace With Fields 

 

Check Boxes 

Check the Match case check box to do case-sensitive searches, and check the Recurse 
Subdirectory check box to search all subdirectories of the working directory. A close-up view of this 
section of the dialog box is shown in Figure 8.4. 

 
Figure 8.4. Check Boxes 

 

Node name only is a special check box that uses Find String and Replace String and adds "\\" or 
"//" at the beginning and "\" or "/" at the end of these strings. This confirms that you have really 
replaced network node names. 

You can modify the AlarmWorX files and GenBroker Configuration files only by selecting Node 
name only.  There is no other text information that you can change. The check boxes for the 
AlarmWorX and GenBroker Configuration files will be grayed out if you uncheck the Node name 
only check box. 

Thus, when you uncheck Node name only, you can use the Change Host Name utility to change, 
for example, a point name in GraphWorX displays and TrendWorX files at the same time. You must 
then enter the original name in the Find What field and the new name in the Replace with field. 

 
Other Options 

The three options to the right of the check boxes allow you to change the name or address in the 
Replace with field. As shown in Figure 8.5, a name appears in the Replace with field if you select 
the MS Network option. 
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Figure 8.5. MS Network Option 

Similarly, another name or address will appear in the Replace with field if you select the DNS or IP 
Address option, as shown in Figure 8.6 and Figure 8.7, respectively. Click the Close button to exit 
from the Change Host Name Utility. 

 

 
Figure 8.6. Domain Name Services Option 

 

 
Figure 8.7. IP Address Option 



WebHMI  

8.4 

 



Chapter 9 

9.1 

WEBHMI VERSION SUPPORT 

Introduction to Version Support 
Version support is a feature in WebHMI that allows for the auto-update of ActiveX components when 
WebHMI clients that have Version 6.0 installed connect to a WebHMI server that has Version 6.1 or 
installed. When ActiveX components are downloaded from a WebHMI server to a WebHMI client 
over the Internet, the ActiveX components are silently installed on the client machine. The ActiveX 
components are delivered into the .cab files archive. The .cab files are referenced in the HTML code 
near the corresponding ActiveX "clsid". Internet Explorer can detect whether ActiveX components 
are present on the client machine. Thus, if an ActiveX is already installed on the client machine, 
then there is no need to download a 2 MB .cab file for that ActiveX. 

For example, suppose that a client machine is running Version 6.0, and you want to connect the 
client machine to a WebHMI Version 6.1 server. In this case, the client machine requires GenBroker 
Version 6.1 support in order to communicate with the WebHMI 6.1 server. It also requires the new 
GraphWorX, AlarmWorX, TrendWorX, and all other ActiveX components from Version 6.1. The 
Smar ActiveX components are backward compatible; you can open a Version 6.0 file from a Version 
6.1 ActiveX component, but you cannot open a Version 6.1 sample file if you have a Version 6.0 
ActiveX component. 

Now, for example, suppose that the client has already been connected to a WebHMI 6.0 server, and 
the client has already installed all the ActiveX support for ProcessView Version 6.0. Also suppose 
that you want to connect the same client to a WebHMI 6.1 server. If there is no version information 
in an HTML page, Internet Explorer will not download the new ActiveX .cab files because the 
ActiveX with the same ID is already registered on the client machine.  

To avoid such compatibility problems, WebHMI adds the correct version number information to 
HTML pages. This is accomplished with the Update Versions Utility. This utility gets the version 
information from an information (.inf) file called "WebHMI.inf," which contains information about the 
entire WebHMI installation, including which archives are installed in which directories, what 
component they contain, and the version numbers of the components installed. 

Update Versions Utility  
The WebHMI Update Versions Utility manages all versioning information on the server side. The 
utility allows you to modify HTML files by adding version information for ActiveX components. The 
version information in HTML files is necessary for the automatic update of ActiveX components. If 
an older version of an ActiveX is already installed and registered on your machine, a newer version 
will be downloaded, but only if the version information is placed in the HTML file. 

The version information is taken from the "WebHMI.inf" file mentioned above. In WebHMI Version 
6.1, the "WebHMI.inf" file is installed by default on the WebHMI server machine in the 
"C:\InetPub\wwwroot\WebHMI" directory. 

The Versions Utility is similar to other "find-and-replace" utilities that search in a specified directory 
for entered files. The utility searches for the occurrence of ActiveX objects in HTML files. If it finds 
any, it then searches the "WebHMI.inf" file for the updated version and inserts the new version 
information into the HTML files. 

Starting the Versions Utility 
To open the Versions Utility from the Windows Start menu, select Programs > WebHMI > 
Versions Utility, as shown in Figure 9.1.  
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Figure 9.1. Starting the Versions Utility 

The Update Versions dialog box will appear, as shown in Figure 9.2.  

Note: The Version Utility is Web-server oriented and should be used by the Web server (WebHMI 
server) administrator only. 

 
Figure 9.2. Update Versions Dialog Box 

The WebHMI Inf File field specifies a path to the information file, which contains version information 
for ActiveX components. The default file is the "WebHMI.inf" file described above. If you want to 
change the file or its location, you can simply type the new location, or click the … button to browse 
for the file. 

The In Files/File Types field contains a list of files and/or file types to search for. The default file 
types are *.htm and *.html; the utility will search for all .htm and .html files in the specified location.  

The In Folder field contains the name of the folder where the search will be started. You can also 
use the … button to change the folder. If the Look In Subfolders check box is checked, the search 
will be recursive for all subdirectories of the selected folder. 

When you click Update, the utility will search for the specified files in the selected directories. If the 
utility finds any of them, it will open each file and search the file for the occurrence of an ActiveX. If 
an ActiveX is found, the utility will search for version information for that ActiveX in the "WebHMI.inf" 
file.  

If the information is found, the updated version information will be automatically appended to the 
.cab file address in the HTML code. For example, a GraphWorX Viewer ActiveX (GWXView32.cab) 
with version 6.10.97.0 in a Web page will be appended to the "CODEBASE" attribute of the 
"OBJECT" block in the HTML code as follows: 

CODEBASE=http://www.WebHMI.com/WebHMI/cabs/GWXview32.cab#Version=6.10.97.0 
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ALARMWORX AND TRENDWORX WEB 
ACCESS 

Introduction  
WebHMI includes new AlarmWorX Web Access support for reports and operator comments. The 
configuration interfaces for the AlarmWorX Report ActiveX and the AlarmWorX Viewer ActiveX have 
been enhanced to enable remote access of Alarm Logger databases over the Internet. 

Web Access for Alarm Reports 
The AlarmWorX Report ActiveX now enables clients to download alarm reports over the Internet. 
The Web Access tab of the Alarm Report ActiveX Properties dialog box, shown below, allows 
you to access the currently connected Alarm Logger database over the Internet via a Remote Data 
Service (RDS). The RDS, which is hosted by an Internet Information Server (IIS), enables the 
downloading of report data from the logger database to a client over the Internet. Simply specify the 
URL name or IP address of the IIS Web server in the Internet Information Server for Remote 
Data Access field, as shown in Figure A.1. You can also specify a maximum number of database 
records to download from the logger database. The default maximum number of records is 1,024. 

Note 
For more information, please see the AlarmWorX Report ActiveX Help documentation. 

 

 
Figure A.1. Alarm Report ActiveX Web Access Tab 

When Internet Access to the logger database is enabled, the client makes a request over the 
Internet to the IIS Remote Data Service. The RDS uses a special component, called the Data 
Factory Handler, to relay the request to the local logger database on the server, as shown in Figure 
A.2. The RDS retrieves the relevant information for the alarm report from the logger database so 
that the client can download the data from the server over the Internet. The client machine then 
displays the data in the Report ActiveX per the client's report configuration settings. 

In most typical scenarios, the Report ActiveX configuration is done on the server side. Those steps 
include:  

• Connection to the database is established by clicking the Connection Parameters button on 
the General tab of the Report ActiveX Properties dialog and using the Database Connection 
dialog. 

• Internet access settings are enabled on the Web Access tab. 
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• Configuration data saved as a *.awr file or a *.gdf display containing the Report ActiveX are 
published to an HTML document on a WebHMI server. 

 
Figure A.2. Downloading Alarm Report Data From a Remote Logger Database 

Web Access Support for Alarm Viewer Operator Comments 
The AlarmWorX Viewer ActiveX now enables clients to download operator comments from a remote database 
over the Internet. The Display tab of the Alarm Viewer ActiveX Properties dialog box, shown in Figure A.3, 
allows you to connect to an operator comments database. 

Note 
For more information, please see the AlarmWorX Viewer ActiveX Help documentation. 

 

 
Figure A.3. Alarm Viewer ActiveX Properties: Display Tab 
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Connecting to the Operator Comments Database  
In most situations, you will use the AWXLog32.mdb Microsoft Access database (located in the 
ProcessView Bin directory) as your operator comments database. This is the standard Alarm Logger 
database. To connect to the operator comments database: 

1. Click the Connection button on the Display tab. This opens the Database Connection dialog 
box, as shown below. 

2. Under Data provider, select Microsoft Access, as shown in Figure A.4. 

 
Figure A.4. Connecting to a Database 

3. Click the Build Connection String button. This opens the Microsoft Data Link Properties 
dialog box, as shown in Figure A.5.  

Note 
All data source connections are made through the Data Link Properties dialog box. The 
Connection tab settings may vary depending on which data provider you selected. Click the OK 
button. Click the Help button at any time to view the Microsoft Data Link help documentation. 
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Figure A.5. Specifying a Data Source 

4. Click the … button and select the AWXLog32.mdb file from the bin directory, as shown in 
Figure A.6. Click the Open button.   

 
Figure A.6. Selecting the Operator Comments Database 

5. The data source reference appears in the Database Connection dialog box in the OLE DB 
Connection String field, as shown below. In the Base Table Name field, select EventLog from 
the drop-down list.  
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Note 

The Base Table list varies according to the active Alarm Logger configuration database. 

 

6. Click the Connect button to connect to the database. The traffic light icon changes to green 
when the connection is successful, as shown in Figure A.7. 

 
Figure A.7. Database Connection  

7. Now you must specify which column in the database table you will use to for logging and storing 
comments. In the Comment box, select a column from the drop-down list. For most cases, only 
the Comment box should be configured.  The exception is the case where the system is logging 
from two different alarm servers, using the same tag names in both alarm server configurations.  
This is the only case where the Node, Server, Op Condition, Op Node, and Op Server 
selections should be used. 

Enabling Remote Web Access to Operator Comments. 
The Alarm Viewer enables you to gain access to operator comments from the currently connected 
Alarm Logger database over the Internet. To enable Web access to operator comments, check the 
Access currently connected database over the Internet via RDS check box at the bottom of the 
Database Connection dialog box. A Remote Data Service (RDS), which is hosted by an Internet 
Information Server (IIS), enables the downloading of operator comments data from the logger 
database to a client over the Internet.  

Once you have connected to the operator comments database. Simply specify the URL name or IP 
address of the IIS Web server in the Internet Information Server for Remote Data Access field in 
the Database Connection dialog box. You can also specify a maximum number of database 
records to download from the logger database.  
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When Internet Access to the logger database is enabled, the client makes a request over the 
Internet to the IIS Remote Data Service. The RDS uses a special component, called the Data 
Factory Handler, to relay the request to the local logger database on the server, as shown in Figure 
A.8.The RDS retrieves the relevant information for the alarm report from the logger database so that 
the client can download the data from the server over the Internet. The client machine then displays 
the data in the Viewer ActiveX per the client's configuration settings. 

In most typical scenarios, the Viewer ActiveX configuration is done on the server side. Configuration 
data saved as a *.awv file or a *.gdf display containing the Viewer ActiveX are published to an HTML 
document on a WebHMI server. 

 
Figure A.8. Downloading Operator Comments From a Remote Logger Database 

Tips for AlarmWorX Remote Data Access 
A good understanding of Remote Data Access principles is a key element to building a successful 
solution for a Web-enabled alarm reporting system. Since the volume of alarm databases can 
reach hundreds of megabytes, it is very important to keep in mind the following aspects. 
 
Maximum Number of Downloadable Database Records and Adequate Record Filtering 

The setting for the maximum number of records to download (Nmax) indicates that any database 
query operations would return no more than Nmax alarm records (lines to the grid). If more than 
Nmax records from the current table match the current filtering criteria, then only the portion of the 
record set containing top Nmax records is returned. To avoid such record set cut-off, strong 
restrictive record filters should be used all the time. Since the record filters are processed on the 
database side, the database server uses all existing records to build the record set.  
 
Proper Choice of the Back-end Database 

It should be noted that the use of Microsoft Access databases (*.mdb) is not recommended for 
Web Access. Poor memory management in Microsoft Jet Engine creates a serious scalability 
problem for any type of Web database application. The recommended back-end database for 
Web alarming is MSDE (Microsoft Desktop Engine) or Microsoft SQL Server. 
Table Management in Alarm Logger Configuration 

To provide further optimization for the Alarm Logger database operations, the table management 
should be enabled in the logger configuration. See the Alarm Logger Configurator documentation 
for more information. 
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Using the Remote Database Access Manager 
The AlarmWorX Remote Database Access Manager, shown in Figure A.9, is a separate utility 
(the AWXRep32RDSSM.exe file) located in the ProcessView Bin directory. This utility configures 
the communication parameters for the Data Factory Handler (described above) so that the 
AlarmWorX Report ActiveX can connect to a remote Alarm Logger database and retrieve data from 
the database. It also enables security for remote database access via the ProcessView Security 
Server. 

 
Figure A.9. AlarmWorX Remote Database Access Manager 

 

Database Connection Options 

The Database Connection Options section of the AlarmWorX Remote Database Access Manager 
sets the following connection parameters for the Data Factory Handler: 

• Connection Retry Number: Specifies the maximum number of times the Data Factory Handler 
will try to reconnect to the Alarm Logger database in case the connection fails. 

• Connection Retry Delay: Sets the amount of time (in seconds) the Data Factory Handler waits 
between subsequent connection retries to the Alarm Logger database. 

 

Security Management 

The AlarmWorX Remote Database Access Manager allows you to enable security for remote 
database access via the ProcessView Security Server. Check the Enable Security Management 
for Remote Database Access (via Security Server) check box. When security is enabled, each 
time a user tries to access the Alarm Logger Database, the Security Server will check to verify 
whether that user is allowed to have remote access to the database. 

Note 
For information about the Security Server configuration and login, please see the Security 
Configurator and Security Login Help documentation. 

 

Because the database is accessed over the Internet via TCP/IP communications, GenBroker 
communications over OPC over TCP/IP must also be enabled. Thus, you must specify a 
GenBroker Configuration File (.gbc or .gbx). Clicking the … button to the right of this field allows 
you to browse for a GenBroker configuration file, as shown in Figure A.10.If you do not specify a 
GenBroker configuration file, or if no Security Server is specified in the GenBroker configuration, 
then the default system GenBroker configuration file will be used. 
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Note 

If you are using WebHMI, it is recommended that the Security Server be located on the same 
machine as the WebHMI Server. For information about how to configure GenBroker 
communications, please see the GenBroker Help documentation. 

 

The GenClient Updates Timeout sets the maximum amount of time (in seconds) the Data Factory 
Handler will wait for Security Server validation of a data request from the client (i.e. the client with 
the Alarm Report ActiveX installed) before returning an "Access Denied" error. 

 
Figure A.10. Selecting a GenBroker Configuration File 

TrendWorX Reporting Tool 
To open the TrendWorX Reporting tool from the Windows Programs menu, select Programs > 
ProcessView > TrendWorX > TrendWorX Reporting. 

The TrendWorX Reporting screen will appear, as shown in Figure A.11. 

 
Figure A.11. TrendWorX Reporting Screen 
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The TrendWorX Reporting tool exports .csv files, databases, and MS Excel Workbooks.  Of these, 
only Excel Workbooks can be imported into HTML files. To do this, configure an Excel-based report 
by selecting Add Report from the Edit menu. This opens the Report Configuration Wizard, which 
is a series of dialog boxes that allow you to configure report. In the Target tab, shown in Figure 
4.12, select Excel File, check the Publish option, and click on the HTML Path button to determine 
where in the directory you wish to place the files. Currently, some server-side scripting may be 
required to generate dynamically HTML pages with all the available reports. In future versions of 
WebHMI, the WebHMI Explorer based on MS Digital Dashboard will do this automatically. 

For a complete guide through the steps in using the TrendWorX Reporting Tool, please see the 
TrendWorX user guide or online help documentation. 

 
Figure A.12. TrendWorX Report Configuration Wizard 
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SETTING UP DCOM 
DCOM As a Requirement 

DCOM is now essential to an up-to-date Windows environment. DCOM is built into Windows NT. 
Users with machines that have Windows 95 or Windows 98 can browse the Smar Product CD to get 
DCOM from Tools/DCOM95 or Tools/DCOM 98, respectively.  
 
Using the Smar Product CD, install the DCOM configuration by clicking on dcm95cfg.exe and then 
the DCOM by clicking on dcom.exe. DCOM settings must be configured carefully and correctly to 
be able to view WebHMI on the server.  
 
The Web server should also have ProcessView installed on it, as Smar ActiveX controls take their 
security and licensing from this registered ProcessView product. 
The steps for configuring DCOM and browsing WebHMI are given below. For further information 
about DCOM, please refer to the Microsoft Windows help documentation. 
 

Note 
If GenBroker TCP/IP channels are used, as they are in WebHMI, neither DCOM settings nor user 
accounts are necessary. The information in this chapter is provided only as a reference for setting 
up DCOM. You should not need this information if you use WebHMI. 

 

Configuring DCOM for Windows NT 

Creating a User Group 
It is necessary to create a group of users who will be able to access WebHMI. This is done either on 
the Domain Controller or the Workstation, whichever may be the case.  
 
To begin, click the Start button and select Programs  > Administrative Tools > User Manager. 
Select User Manager, as shown in Figure B.1. 

 
Figure B.1. Opening the User Manager Screen 

The User Manager screen will appear, as shown in Figure B.2. Select New Local Group from the 
User menu. 
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Figure B.2. User Manager Screen 

 

 
Figure B.3. New Local Group Dialog Box 

The New Local Group dialog box will appear, as shown in Figure B.3. In the Group Name field, 
type "WebHMIUsers" and click the OK button. The group name "WebHMIUsers" will appear in the 
bottom pane of the User Manager screen. Double-click the on WebHMIUsers. The Local Group 
Properties dialog box will appear, as shown in Figure B.4. On the Local Group Properties dialog 
box, click the Add button. 
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Figure B.4. Local Group Properties Dialog Box 

The Add Users and Groups dialog box will appear, as shown in Figure B.5. In the Names field of 
the Add Users and Groups dialog box, select each name that you wish to add to the 
"WebHMIUsers" group. After selecting the name, click the Add button, as shown below. 
 

Note 
For the purposes of the example given here, we have chosen QA_LAB for the List Names From 
field. You will probably use another source of names when configuring your new user groups. 

 
Each time that you choose a name and click the Add button, that name will appear in the Add 
Names pane, as shown below. To find a name that does not appear in the Names pane, click the 
Search button, as shown in Figure B.5. 
 

 
Figure B.5. Names Added to "WebHMIUsers" Group 
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Figure B.6. Add a Found Name to the Add Names Pane 

The Find Account dialog box will appear, as shown in Figure B.6. In the Find User or Group field, 
type the name of the user or group for which you are searching, and then click the Search button.  
 
If the name for which you are searching is found, it will appear in the Search Results field of the 
Find Account dialog box. Click the Add button to place the name in the Add Names pane of the 
Add Users and Groups dialog box, as shown in Figure B.6. After you have placed all of the names 
in the Add Names pane, click the OK button on the Add Users and Groups dialog box. 
 

This will cause the Local Group Properties dialog box to appear, as shown in Figure B.7. Click the 
OK button on the Local Group Properties dialog box.  This will cause the User Manager dialog 
box to reappear. You have now created the "WebHMIUsers" Group. To conclude this phase of the 
DCOM setup, select Exit from the User menu of the User Manager dialog box. 
 

 
Figure B.7. Local Group Properties Dialog Box 
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Configuring DCOM Properties  
To begin configuration of the DCOM properties, click the Start button and select Run from the 
Windows Start menu. The Run dialog box will appear, as shown in Figure B.8. Type "dcomcnfg" in 
the Open field, and then click the OK button. 

 
Figure B.8. Opening the dcomcnfg Folder 

The Distributed COM Configuration Properties dialog box will open, as shown in Figure B.9. 
Click on the Default Properties tab of the Distributed COM Configuration Properties dialog box. 

 

 
Figure B.9. Distributed COM Configuration Properties Dialog Box  

 
The Default Properties tab will appear, as shown in Figure B.10. Check Enable Distributed COM 
on this computer. Doing so allows DCOM objects to be created on this machine. Select Connect 
in the Default Authentication Level field. Select Identify in the Default Impersonation Level field. 
You do this in case security is absent at the object level; the server will then use this level to check 
permissions in the ACL (Access Control List) of the client machine. 
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Figure B.10. Configuring the Default Properties 

 

Click on the Default Security tab to have its page appear, as shown in Figure B.11. Click the Edit 
Default button. 

 
Figure B.11. Default Security Tab 
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This opens the Registry Value Permissions dialog box, shown in Figure B.12. Click the Add 
button. 

 
Figure B.12. Registry Value Permissions Dialog Box 

 
This opens the Add Users and Groups dialog box, shown in Figure B.13. In the Names field, 
scroll down to WebHMIUsers, and then click the Add button. "WebHMIUsers" will appear in the 
Add Names field, as shown in Figure B.13. With "WebHMIUsers" now in the Add Names field and 
Allow Access set in the Type of Access field, click the OK button. 

 

 
Figure B.13. WebHMIUsers Placed in Add Names Field 
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The Registry Value Permissions dialog box will appear, as shown in Figure B.14. With 
"WebHMIUsers" now in the Name field and "Allow Access" set in the Type of Access field, click the 
OK button. 

 
Figure B.14. "WebHMIUsers" Added to Name Field 

 
The Distributed COM Configuration Properties dialog box will appear, as shown in Figure B.15. 
In the Applications tab, select Security Server, and then click the Properties button. 

 
Figure B.15. Setting Properties of Security Server 

 
The Security Server Properties dialog box will appear, as shown in Figure B.16. On the General 
tab of the Security Server Properties dialog box, make sure that the Authentication Level field is 
set to Default. Then click on the Security tab. 
 



Setting up DCOM 
 

Ap.B9 

 
Figure B.16. Security Server Properties Dialog Box 

 
The Security tab page will appear, as shown in Figure B.17. On the Security tab, make sure to 
select Use default access permissions, Use default launch permissions, and Use custom 
configuration permissions. Then click on the Location tab. 
 

 

Figure B.17. Setting Permissions  
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The Location tab will appear, as shown in Figure B.18. On the Location tab, check Run 
application on this computer. Click the OK button. The Distributed COM Configuration 
Properties dialog box will reappear. Click the OK button. 
 

 
Figure B.18. Location Settings 

 
You have now completed the DCOM setup process for Windows NT.  
 

Configuring DCOM for Windows 95 and 98 

Using a Windows 95 or 98 Machine As a Web Server  
Computers with Windows 95 or Windows 98 installed must belong either to a domain or a 
workgroup. To let this Web server know about all of the permitted users, select Run from 
the Start menu, as shown in Figure B.19. 

 
Figure B.19. Opening the Control Panel 
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The Run dialog box will appear, as shown in Figure B.20. Type "dcomcnfg" in the Open field, and 
then click the OK button. 

 

 
Figure B.20. Run Dialog Box 

The Distributed COM Configuration Properties dialog box will appear. Click on the Default 
Properties tab to open the Default Properties tab page, shown in Figure B.21. Select None in the 
Default Authentication Level field, and select Identify in the Default Impersonation Level field. 

 

 

 
Figure B.21. DCOM Configuration Properties Dialog Box 
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Click on the Default Security tab, shown in Figure B.22, and then click the Edit Default button. 

 
Figure B.22. Default Security Tab 

 
The Access Permissions dialog box will appear, as shown in Figure B.23. Under the name field, 
select the names of all domain or workgroup users, and then click the Add button. 
 

 
Figure B.23. Access Permissions Dialog Box 
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Figure B.24. Add Access Permissions Dialog Box 

 
The Add Access Permissions dialog box will appear, as shown in Figure B.24. The names that 
you have selected will appear in the Name field and in the right-hand pane. Click the Grant Access 
button, and then click the OK button. 
 
The Distributed COM Configuration Properties dialog box will reappear. On the Default Security 
tab page, check the Enable remote connection check box. 
 
Now click on the Applications tab of the DCOM Configuration Properties dialog box. In the 
Applications field, select Security Server, and then click the Properties button, as shown in 
Figure B.25. 

 

 
Figure B.25. Selecting Security Server 

 



WebHMI  
 

Ap.B14 

The Security Server Properties dialog box will appear, as shown in Figure B.26. On the Security 
tab page, select Use default access permissions. 
 

 
Figure B.26. Security Server Properties 

 

 
Figure B.27. Location Tab 
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As shown in Figure B.27, on the Location tab, check the Run application on this computer 
option. To return to the Distributed COM Configuration Properties dialog box, click the Apply 
button. 
 
The Default Properties tab page of the Distributed COM Configuration Properties dialog box will 
reappear. Click the Apply button.   
You have completed DCOM setup for Windows 95 and 98.  
 
It is, however, strongly suggested that Windows NT be used as the Web server. If there are two NT 
machines in a workgroup, then you have to create the same group of users ("WebHMIUsers") on 
these machines. Alternatively, the same user with the same password should log in at any given 
time on these two PCs. 
 
If all the computers are in a domain, then the client PCs need not have a list of all users 
(WebHMIUsers) on them, since the domain controller takes care of granting or denying permissions. 
On the Windows 95/98 client machines, you should do the setup in such a way that they receive 
their list of users from the domain controller or the NT workstation, whichever is pertinent. To do 
this, go to Network Properties > Access Control. In the Obtain list of Users and groups from 
field, type in the PC name of the Workstation (where the workgroup was created) or the PC name of 
the PDC (domain controller where the domain was created), whichever is pertinent. 
 

Domains, Workgroups, Rights to the Server Node and DCOM  
DCOM's complexity recommends its use only for intranet and LAN applications. 

For WebHMI to function correctly or, more specifically, to establish proper DCOM intranet 
communication, all client WebHMI PCs must be in the same workgroup or domain as the WebHMI 
server node.  
 
The DCOM default launch and default configuration settings on the server node must be configured 
so that everyone logged in on the WebHMI client PC has access to the server node. Any user 
logged in on a client PC must also have the proper rights to browse the WebHMI server.  
 
For the proper transmittal of information over DCOM between two PCs, these two nodes must be in 
either the same workgroup or domain.   
In any networked application, all of the computers must share common information. From Smar' 
point of view, the most important function of such applications is to enable the sharing of user-
related information. 
 
In a workgroup, you have to configure this information individually on each machine. In a domain, 
one main computer, typically called the Primary Domain Controller (PDC), stores all of this 
information. When a new PC joins the network: 
• In a workgroup, you must configure all of the settings manually. 

• In a domain, the PDC will automatically send them to the new PC. 
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